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Pages and Spaces Overview

FAQ
How do I attach a large file to a page?
How do I move the attachments to the filesystem?
How do I create a space template?
How do I create a page template?

Attach Large Files
XWiki Enterprise has a new file-system attachment storage allowing you to add very large attachments to the wiki documents.
This feature is disabled by default, but you can enable it by editing the xwiki.cfg file and by making the following changes
under the Storage section:

#-# The attachment storage.
xwiki.store.attachment.hint=file
#-# The attachment versioning storage. Use 'void' to disable attachment versioning.
xwiki.store.attachment.versioning.hint=file
#-# The attachment recycle bin storage
xwiki.store.attachment.recyclebin.hint=file

In order for the changes to be taken into account, you will have to restart the server.

Next, you need to set the maximum size of the attachment. To do that, just edit the XWiki.XWikiPreferences page in
"Objects" mode (e.g. ServerName/xwiki/bin/edit/XWiki/XWikiPreferences?editor=object) and replace the value of the "Maximum
Upload Size" property with a huge number (for instance "999999999999").

Store Attachments on the Filesystem
In order to move the attached files from the database to the file-system, you can use the "Filesystem Attachment Porter"
tool available here. You just have to download the snippet, edit it and copy the code in any wiki page, for instance in
"XWiki.FSPorter".

The first step is to enable the file-system attachment storage as explained in the above section, then to restart the server. If the
configuration is correct, when you navigate to "XWiki.FSPorter" you should see the following 3 lines colored in green:

* org.xwiki.store.legacy.store.internal.FilesystemAttachmentStore@3b69d6d3
* org.xwiki.store.legacy.store.internal.FilesystemAttachmentVersioningStore@2196d51e
* org.xwiki.store.legacy.store.internal.FilesystemAttachmentRecycleBinStore@3581b5cc

The attachments will be copied from the database into the permanent directory set for the servlet container. 

http://extensions.xwiki.org/xwiki/bin/view/Extension/Filesystem+Attachment+Porter
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Note that the file-system porter will copy the attachments from the database to the storage folder but it will not delete the entries
from the database. It is recommended to keep the attachments in the database that after the copy process finishes.

The "Dry Run" option allows you to do a simulation in order to check for corrupted attachments without necessarily having
the file-system storage enabled.

The "Verbose" option displays each attachment as it is processed. 

Once you click the "Start" button, the script will work in 20 second chunks and print the results of each chunk. In order for
the script to switch to the next chunk you will have to click the "Continue" button.

 

Related Pages

• User Guide
• Page Attachments

• Programming Guide
• Zip Explorer Plugin
• Attachment Selector Macro

• Admin Guide
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• WebDAV
• Pages and Spaces Overview
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WebDAV
The WebDAV feature exposes wiki content like attachments or page content through the well-known WebDAV protocol. This
allows using WebDAV clients like DAVExplorer, file browsers like the Windows Explorer (XP), the Finder (MAC) or
Nautilus (Linux) to directly browse and edit wiki content just as you would do for files in your local file system.

XWiki.org when seen while browsing it using a file manager over WebDAV

Here are some benefits of a webDAV-enabled XWiki installation:

• Mount an XWiki wiki content into the user's local file system.
• Use local application programs to manipulate page content and attachments.
• Easily perform batch operations on documents (e.g. add 100 attachments to a document).

XWiki's WebDAV implementation doesn't support locking and versioning DAV operations yet, but you can use the Basic
Access Authentication method.

WebDAV Clients
The XWiki-WebDAV interface requires a WebDAV client installed, but nowadays operating systems have built-in WebDAV
clients. There are many WebDAV clients and their behavior may vary because functionalities might not be unique. In the
worst case, they might even be broken on some clients. We will keep updating this document with instructions on how to use
the various WebDAV clients to access the XWiki-WebDAV interface. In the mean time, if you find out that your particular
WebDAV client has problems with accessing / using the XWiki-WebDAV interface, you may consult the community for
reporting issues.

WebDAV clients known to work with the XWiki-WebDAV interface:

• DAVExplorer - Platform Independent
• WebFolders - Windows XP
• WebDAV Redirector - Windows XP
• NetDrive / WebDrive - Windows XP
• BitKinex - Freeware for Windows
• Nautilus - Gnome (Linux)
• Konqueror - KDE (Linux)
• Davfs2 - Linux

 

http://en.wikipedia.org/wiki/WebDAV
http://dev.xwiki.org/xwiki/bin/view/Main/WebHome
http://platform.xwiki.org/xwiki/bin/view/Features/WebDAVDAVExplorer
http://platform.xwiki.org/xwiki/bin/view/Features/WebDAVWebFolders
http://platform.xwiki.org/xwiki/bin/view/Features/WebDAVRedirector
http://platform.xwiki.org/xwiki/bin/view/Features/WebDAVNetDriveOrWebDrive
http://www.bitkinex.com/webdavclient
http://platform.xwiki.org/xwiki/bin/view/Features/WebDAVNautilus
http://platform.xwiki.org/xwiki/bin/view/Features/WebDAVKonqeror
http://platform.xwiki.org/xwiki/bin/view/Features/WebDAVDavFs2
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Create a Page Template
To create a generic page template, hover the "Home" menu for the main wiki

or the "Wiki" menu for a sub-wiki and click on "Administer Wiki". 

In the wiki administration page, click on the "Templates" link from the vertical menu to the left.

Fill in the template name and the space name then click on "Create".
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The template document will automatically open in "Inline" mode. In the "Template Name" input you can fill in a translation key
to allow internationalization of the template name. 

If the page specified in the "Template to Use" text-box is not found, the "Edit" button to the right will redirect you to the
creation form.
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Choose "Page" for the "Template Type" and select the action to execute when the user clicks on the "Create" button. This
option allows you to decide whether the new document will be saved or not before being opened for edition and the possible
choices are "Edit" and "Save and Edit". You can also decide on which spaces will the new template be available but note that in
case you don't select any option, it will be available on all spaces. 

Click on "Save & View" to complete the process.
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To see the list of available templates, click on "Go back to the wiki administration".

To learn how to create a space template, go to the dedicated documentation page.

   

Related Pages

• User Guide
• Watch a Space
• Index Application
• Create and Delete a Space
• Create a New Page

• Admin Guide
• Set the Space Access Rights
• Pages and Spaces Overview
• Create a Space Template
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Create a Space Template
A space template does not represent an actual space, but a space home page or dashboard template. To create a custom one,
hover the "Home" menu for the main wiki

or the "Wiki" menu for a sub-wiki and click on "Administer Wiki". 

In the wiki administration page, click on the "Templates" link from the vertical menu to the left.

Fill in the template name and the space name then click on "Create".
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The space template page will automatically open in "Inline" mode. In the "Template Name" input you can fill in a translation
key to allow internationalization of the template name. 

If the page specified in the "Template to Use" text-box is not found, the "Edit" button to the right will redirect you to the
creation form.

Finally, choose "Space homepage" for the "Template Type" and select the action to execute when the user clicks on the "Create"
button. This option allows you to decide whether the new document will be saved or not before being opened for edition and the
possible choices are "Edit" and "Save and Edit".

Click on "Save & View" to complete the process.
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To see the list of available templates, click on "Go back to the wiki administration".

To learn how to create a page template, go to the dedicated documentation page.

   

Related Pages

• User Guide
• Watch a Space
• Index Application
• Create and Delete a Space
• Create a New Page

• Admin Guide
• Set the Space Access Rights
• Pages and Spaces Overview
• Create a Page Template
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Activity and Watch Overview

FAQ
How do I enable the Google Analytics tracking?
How do I enable the XWiki Statistics?
How can I access the document related statistics?
How can I access the referrer statistics?
How can I access the visit statistics?
How can I access the activity statistics?
How can I display the XWiki statistics in a panel?

Activate and Configure Google Analytics
Wiki administrators use the Google Analytics (GA) service in order to get detailed statistics about the visitors. XWiki Enterprise
provides a dedicated section in the wiki preferences page for activating the Google Analytics tracking. 

To enable Google Analytics, hover the "Home" menu for the main wiki 

or the "Wiki" menu for a sub-wiki and click on "Administer Wiki". 

Next, in the administration page, click on the "Google Analytics" link from the vertical left menu to the left.



XWiki Enterprise 5.4.4 Admin Guide

Page 20

XWiki Enterprise allows you to define different tracking accounts for each wiki and to use more than one tracking account
per wiki. All you need to do is to enter your Google Analytics account in the "Account" text area and to click on "Save". The
account format is UA-xxxxxxx-x. It is also possible to enter several GA accounts separated by a space. 

Moreover, you can set the tracking method you chose when creating the Google Analytics account: Universal or Classic.

  

Related Pages
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• Programming Guide
• The "xwikistatsvisit" Table
• The "xwikistatsreferer" Table
• The "xwikistatsdoc" Table

• Admin Guide
• XWiki Statistics Application
• Activity and Watch Overview



XWiki Enterprise 5.4.4 Admin Guide

Page 22

XWiki Statistics Application
• Enable Statistics

• Enable Statistics from the Configuration File
• Enable Statistics from XWiki.XWikiPreferences

• Access the Statistics Page
• Document Statistics
• Referrer Statistics
• Visit Statistics
• Activity Statistics
• Display Wiki Statistics in Panels
• Change the Default Number of Results

Enable Statistics

Enable Statistics from the Configuration File

In XWiki Enterprise, the Statistics feature is disabled by default. In order to enable it, a system administrator has to edit the
xwiki.cfg configuration file and make sure the value of the properties xwiki.stats and swiki.stats.default is
set to 1, as shown below:

xwiki.stats=1
xwiki.stats.default=1

The parameter xwiki.stats controls whether the Statistics feature is on or off.
The parameter xwiki.stats.default controls whether the Statistics feature is on or off by default for the current Wiki.

A restart of the wiki will be necessary to apply the changes. 

Enable Statistics from XWiki.XWikiPreferences

Since there is no UI available for enabling statistics, you will need to modify the administration page. First of all, edit the
"XWiki.XWikiPreferences" class (ServerName/xwiki/bin/edit/XWiki/XWikiPreferences?editor=class) and add a Boolean
property named statistics.

Next, edit the "XWiki.XWikiPreferences" page in "Objects" mode (ServerName/xwiki/bin/edit/XWiki/XWikiPreferences?
editor=object), expand the "XWiki.XWikiPreferences" object and set the "Statistics" property to "Yes".
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Access the Statistics Page
In order to access the Statistics home page click on the "Statistics" link in the "Applications" panel.

You will notice that a panel is displayed for each of the 4 types of statistics.

XWiki Enterprise tracks 4 types of statistics information:
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• Document statistics
• Referrer statistics
• Visit statistics
• Activity statistics

Document Statistics
To access this page, click on the "Document Statistics" link in the bulleted list to the bottom of the home page (ServerName/
xwiki/bin/view/Stats/) or type the following URL: ServerName/xwiki/bin/view/Stats/Document.

By default, the document statistics include:

• a tracking of the most viewed and edited wiki pages.
• a tracking of the most viewed and edited wiki spaces.

Referrer Statistics
This page is available by clicking on the "Referrer" link in the bulleted list to the bottom of the home page (ServerName/xwiki/
bin/view/Stats/) or by typing the following URL: ServerName/xwiki/bin/view/Stats/Referrer.

The Referrer page contains statistics about:

• the addresses of the web pages linking to your wiki (the Best Referrers panel).
• the most referred pages (the Most Referred Pages panel).
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Visit Statistics
To access this page, click on the "Visit Statistics" link in the bulleted list to the bottom of the home page (ServerName/xwiki/bin/
view/Stats/) or type the following URL: ServerName/xwiki/bin/view/Stats/Visit.

The visit statistics list:

• the most active contributors
• the least active contributors

The Changes column allows you to know how many times the page in question has been edited.

Activity Statistics
This page is available by clicking on the "Activity Statistics" link in the bulleted list to the bottom of the home page
(ServerName/xwiki/bin/view/Stats/) or by typing the following URL: ServerName/xwiki/bin/view/Stats/Activity.

The Activity statistics track:

• the current week activity
• the current month activity
• the current year activity
• all time activity
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By default, these statistics count the non-unique visitors.

Display Wiki Statistics in Panels
XWiki Enterprise comes with the Statistics Application which provides panels to display wiki related statistics. To access those
panels, hover the "Wiki" menu and click on "Administer Wiki". In the global Administration page, click on the "Panel Wizard"
link in the vertical menu to the left. The statistics panels are displayed under the "Information" category.
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To make any of these panels available in your wiki, go to the "Panels" documentation.

As the wiki grows bigger and it contains many spaces, pages and users, performance issues might appear causing an increased
loading time for the Panel Wizard. At the moment, the easiest way to avoid this situation is to comment the code for the panels
in the pages Document Statistics and  Visit Statistics. To do so, edit each panel in "Inline" mode as explained above and place
the code between #* and *#.

Change the Default Number of Results
Supposing you want to change the default number of users listed in the "Most Active Contributors" panel, you need to go to the
'Panel Wizard' section of the global Administration page. Next, search for the panel in question in the "Information" category
and click on "Edit" which will make the panel available for edition in "Inline" mode.
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In the "Content" text area, search for the line

$xwiki.criteriaService.rangeFactory.createHeadRange(5))

and replace the number "5" (the default value) with your value.
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Related Pages

• Programming Guide
• The "xwikistatsvisit" Table
• The "xwikistatsreferer" Table
• The "xwikistatsdoc" Table

• Admin Guide
• Activity and Watch Overview
• Activate and Configure Google Analytics
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Import and Export Overview
The Import and Export tools allow you to import one or several pages from an existing XWiki Archive (XAR file) and to export
one or several pages from your wiki to different formats.

FAQ
How do I import a XAR file?
How do I export the whole wiki?
How do I export a selection of pages?

Import
To access the import UI, hover the "Home" menu for the main wiki

or the "Wiki" menu for a sub-wiki and click on "Administer Wiki".

In the wiki preferences page, click on the "Import" link from the vertical menu to the left.

Click on "Browse" to select the XAR file you wish to import and it will be automatically uploaded.
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The File Upload widget provides an interactive upload User Interface in order to enhance the HTML input elements of
type file. To learn more about the configuration options, go to the "HTML 5 File Upload Widget" documentation page listed
in the "Related Pages" section.

Click on the XAR in the "Available Packages" section

and should soon see the preselected page list of your XAR.

If you don't want to preserve the page history, the newly imported pages will have the revision set to "1.1". In case you want
to keep the author of the imported pages, check the "Import as backup package" option.
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Finally, click on the "Import" button to confirm.
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Related Pages

• User Guide
• WYSIWYG Editor
• Version Control
• The Office Importer Application
• Page History
• Page Export Formats
• Page Attachments

• Programming Guide
• The "xwikircs" Table
• HTML5 File Upload Widget
• Customize the Look and Feel of the PDF and RTF Export

• Admin Guide
• Import and Export Overview
• Export Wiki
• Configure the Office Server
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Export Wiki
To get to the export UI, hover the "Home" menu for the main wiki

or the "Wiki" menu for a sub-wiki and click on "Administer Wiki".

In the wiki preferences page, click on the "Export" link from the vertical menu to the left.

Fill in the form and click on the "Export" button.
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When performing an export, wiki pages are saved using the XAR format, which is a renamed ZIP format with a package.xml
file containing metadata about the export. A typical XAR created when doing an export will include all the pages on your
XWiki instance.

Customize the XAR
It is possible to create a XAR that will include only the pages you want. This is useful for example when you want to export
only the pages of a specific application. Here are the steps:

• Unzip the file.
• Keep the pages you want to put in your archive.
• Edit package.xml to delete the pages you do not want to be in the archive.
• Zip together the modified package.xml file and the pages you want to put together in your archive
• Name the file "MyArchive".xar where "MyArchive" is the actual name you want to give it.

Read about the complements of the Import/Export Application in XWiki Enterprise by following this link.

  

Related Pages

• User Guide
• WYSIWYG Editor
• The Office Importer Application
• Page Export Formats

• Programming Guide
• Customize the Look and Feel of the PDF and RTF Export

• Admin Guide

http://extensions.xwiki.org/xwiki/bin/view/Extension/Import+Export+Application
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• Import and Export Overview
• Import
• Configure the Office Server
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Users and Groups Overview

FAQ

Login and Registration

What is LDAP authentication and how can I configure it?
How to set up the configuration file for Microsoft Active Directory?
How to set up the configuration file for Open Directory Server?

User and Group Directory

How do I create a global user?
What is the difference between a local user and a global user?
How do I access the list of global users?
How do I access the list of local users?
How do I edit a global user?
How do I delete a user from the wiki?
How do I create a global group?
What is the difference between a global group and a local group?
How do I access the list of global groups?
How do I access the list of local groups?
How do I add a new member to a global group?
Can I add a whole group to a global group?
How do I delete a user from a global group?
How do I edit a local group?
How do I delete a global group?

Sub-Wiki Membership

How do I see the members of a sub-wiki
How do I add users to a sub-wiki
How do I invite users to a sub-wiki
How do I cancel an invitation to join a sub-wiki
How do I accept a join request from an user?
How do I reject a join request from an user?
How do I remove an user from a sub-wiki

Create a Global User
Global users can be created only in the main wiki. To do so, log in as administrator, hover the "Home" menu and click on
"Administer Wiki".

In the wiki administration page, click on the "Users" link from the vertical menu to the left in order to bring up an overview of
all users.
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Next, click on the "Add new user" button,

fill in all the required user information and click on "Save".
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You can now see the user you have just created in the user list.

   

Related Pages

• User Guide
• XWiki Login
• User Status
• User Directory
• Registration

• Admin Guide
• Users and Groups Overview
• The Management of Global/Local Users and Groups
• Set the Users Access Rights
• Manage the Sub-Wiki Users
• Edit a Global User
• Edit a Global Group
• Delete a Global User
• Customize the User Registration Process
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Edit a Global User
You may edit a global user only in the main wiki. To do so, log in as administrator, hover the "Home" menu and click on
"Administer Wiki".

In the wiki preferences page, click on the "Users" link from the vertical menu to the left in order to bring up an overview of all
users.

Click on the yellow pen icon in the "Manage" column corresponding to the user you want to edit,

change or fill in the user information and click on "Save".
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Related Pages

• User Guide
• XWiki Dashboard Application
• User Status
• User Profile
• User Preferences
• User Directory
• Registration

• Admin Guide
• Users and Groups Overview
• The Management of Global/Local Users and Groups
• Set the Users Access Rights
• Manage the Sub-Wiki Users
• Edit a Global Group
• Delete a Global User
• Customize the User Profile Sections
• Create a Global User
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Delete a Global User
You may delete a global user only from the main wiki. To do so, log in as administrator, hover the "Home" menu and click on
"Administer Wiki".

In the wiki preferences page, click on the "Users" link in the vertical menu to the left in order to bring up an overview of all
users.

To delete an user, click on the X button in the corresponding "Manage" column.

The user will be automatically removed from all the groups it was a member of.
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You won't be able to delete the user you are currently logged in with, so you will need to log using other credentials in order to
perform this operation.

  

Related Pages

• User Guide
• User Status
• User Directory
• Registration

• Admin Guide
• Users and Groups Overview
• The Management of Global/Local Users and Groups
• Set the Users Access Rights
• Manage the Sub-Wiki Users
• Edit a Global User
• Edit a Global Group
• Create a Global User
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Create a Global Group
Global groups can be created only in the main wiki. To so so, log in as administrator, hover the "Home" menu and click on
"Administer Wiki".

In the wiki administration page, click on the "Groups" link in the vertical menu to the left to bring up an overview of all groups.

Click on the "Add new group" button to open the group creation light-box as shown in the image below.

Enter the group name and click on the "Create Group" button.
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You will see the newly created group in the livetable.

  

Related Pages

• Admin Guide
• Users and Groups Overview
• The Management of Global/Local Users and Groups
• Set the Group Access Rights
• Edit a Global Group
• Delete a Global Group
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Edit a Global Group
• Add a User to a Group
• Add a Subgroup
• Remove an User or a Subgroup from a Group

You may edit a global group only in the main wiki. To do so, log in as administrator, hover the "Home" menu and click on
 "Administer Wiki".

In the wiki preferences page, click on the "Groups" link to bring up an overview of all groups.

At this point you have two options:
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• Click on the group name then edit the page in "Inline" mode to display the group members (if any).

• Click on the pencil icon in the "Manage" column of the livetable which will open a lightbox with the group members.

Add a User to a Group
For both options you can add a new user to the group by typing the username in the input below "Users to Add". After starting
to type, if the user exists, the suggest feature will help you by displaying the list of all occurrences, so you can select from them. 

XWiki Enterprise comes with a User Picker which is used by default by all the XCLASS properties of type "List of Users".
The picker displays the user avatar and a link to the user profile and it also allows you to add multiple users in one step.

Since for a wiki group the multiple selection is enabled, each selected user is added to a temporary list above the picker.
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To remove an user from the list, just hover it and click on the red "X" in the top right corner.

You may remove all users at once by clicking on the "Clear selection" link.

Once you are done creating the list, click on "Add" and the new users will also appear in the livetable.

Add a Subgroup
You can add an entire group to the current group. This can be done by typing the group name in the input below "Subgroups to
Add" then by selecting the group from the suggested list. 
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XWiki Enterprise comes with a Group Picker which is used by default by all the XCLASS properties of type "List of
Groups". The picker allows you to add multiple subgroups in one step. Similarly to the User Picker, the group alias is the name
of the group document, the group name is the title of the group document and the group avatar is the first image attached to the
group document.

If multiple selection is enabled, each selected subgroup is added to a temporary list above the picker.

To remove a subgroup from the list, just hover it and click on the red "X" in the top right corner.

You may remove all subgroups at once by clicking on the "Clear selection" link.

Once you are done creating the list of new subgroups, click on "Add" and they will also appear in the livetable.
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Remove an User or a Subgroup from a Group
To delete an user or a subgroup, click on the corresponding X icon or on the "Remove" link in the "Manage" column.

    

Related Pages

• User Guide
• User Status
• User Directory
• Registration

• Admin Guide
• Users and Groups Overview
• The Management of Global/Local Users and Groups
• Set the Users Access Rights
• Set the Group Access Rights
• Edit a Global User
• Delete a Global User
• Delete a Global Group
• Create a Global User
• Create a Global Group
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Delete a Global Group
You may delete a global group only from the main wiki. To do so, log in as administrator, hover the "Home" menu and click on
"Administer Wiki".

In the wiki preferences page, click on the "Groups" link in the vertical menu to bring up an overview of all groups.

Delete a group by clicking on the corresponding X button in the "Manage" column. 

Note that when you delete a group, the users or groups in that group are not deleted. If you also want to delete the members of
the group, you will have to delete them manually from the "Users" and "Groups" administration sections.

  

Related Pages
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• Admin Guide
• Users and Groups Overview
• The Management of Global/Local Users and Groups
• Set the Group Access Rights
• Edit a Global Group
• Create a Global Group
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The Management of Global/Local Users and Groups
• Global Users versus Local Users

• Browse the List of Main Wiki Users
• Edit a Global User

• Browse the List of Local Users
• Edit a Local User

• Global Groups versus Local Groups
• Browse the List of Global Groups

• Edit a Global Group
• Browse the List of Local Groups
• Edit a Local Group

• Add an User to a Local Subgroup
• Add a Subgroup to a Local Group
• Delete an User or a Subgroup From a Local Group

An XWiki Enterprise instance consists of a main wiki which is also named the Wiki Manager and a number of sub-wikis.
Therefore, the users, groups and rights management can be done globally or locally.

Global Users versus Local Users
Global users are created on the main wiki and the rights granted there will also apply on the sub-wikis. Local users are created
on each sub-wiki and they will only be editors or administrators on that particular sub-wiki. 

Browse the List of Main Wiki Users

Go to any main wiki page, hover the "Home" menu and click on "Administer Wiki".

In the wiki administration page, click on the "Users" link in the vertical menu to the left
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and you will see the global users overview.

 

Edit a Global User

Global users can only be edited in the main wiki. To do so, go to the administration page of the main wiki and follow the steps
described in the dedicated documentation page.

Browse the List of Local Users

Go to any sub-wiki page, hover the "Wiki" menu and click on "Administer Wiki". In the administration page, click on the
"Users" link in the vertical menu to the left.
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Depending on the option you chose when creating the sub-wiki, you will see one of the 3 possible user interfaces.

If the sub-wiki has only global users, you should see a livetable named "Current Members" with the main wiki users that have
been added or invited to the sub-wiki.
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In case the sub-wiki has both local and global users, the "Current Members" livetable will display, besides the main wiki
users, the list of local sub-wiki users.
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To create a local user, click the "Add new user" button in the "Users" section and follow the instructions described here. New
local users will be automatically added as members and displayed in the "Current Members" livetable.

By default, only local users will be listed in the "Users" livetable but you can also choose to display the global users or both
categories by selecting the corresponding option from the "Manage" column.
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Finally, if the sub-wiki only has local users, you will see just the "Users" livetable and a button for creating new ones. This
time too, only local users will be listed but you can still switch to "Global" or "Both".

Edit a Local User

Local users can only be edited in the sub-wiki they were created on. For more details, follow this link.

Global Groups versus Local Groups
Just like in the case of global users, global groups are created on the main wiki and any rights granted to them will also apply
on the sub-wikis. Local groups are created on each sub-wiki and they can contain both local and global users and subgroups
whereas global groups can only have global members and subgroups.

Browse the List of Global Groups

Go to any main wiki page, hover the "Home" menu and click on "Administer Wiki". In the wiki administration page, click on
the "Groups" link in the vertical menu to the left 
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which will bring an overview of the global groups.

Edit a Global Group

Global groups can only be edited in the main wiki by adding or removing global users and global subgroups. For more details,
follow this link.

Browse the List of Local Groups

Go to any page of the sub-wiki, hover the "Wiki" menu and click on "Administer Wiki". In the preferences page, click on the
"Groups" link in the vertical menu to the left. Just like for local users, only local groups are displayed by default in the livetable:

• XWikiAdminGroup includes all the local sub-wiki administrators. By default this group is empty.
• XWikiAllGroup includes all the users that were added or invited to the sub-wiki, as explained in the above section.
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In case you want to list the global groups or should you prefer to display both categories, just select the corresponding option
from the drop-down list in the "Manage" column.

The global groups names are not clickable and the number of members is not displayed which means that they can only be
accessed or edited in the main wiki.

Edit a Local Group

Go to the local group overview page and you have 2 options:

•  Click on the group name to open the group page. Next, click on the "Edit" menu to open the group page in "Inline"
mode.

• Click on the pencil icon in the "Manage" column which will open a light-box displaying the members of the local group.



XWiki Enterprise 5.4.4 Admin Guide

Page 61

Add an User to a Local Subgroup

In both cases you can add a new user to the group by typing the username in the input near "Add user to group". Provided the
sub-wiki is configured to support this, you can add both local and global users by first selecting the corresponding option in the
drop-down list. After starting to type, if the user exists, the suggest feature will help display the list of occurrences, so you can
select from them.

XWiki Enterprise comes with a new User Picker which is used by default by all the XCLASS properties of type "List of
Users". The picker displays the user avatar and a link to the user profile and it also allows you to add multiple users in one step.
The process is the same as for global users. In order to toggle between the local and global scope, click on the globe icon. If you

are in local scope, the icon will be ,

whereas in global scope, the icon will be .
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Add a Subgroup to a Local Group

You can also add an entire group to the current local group.This can be done by typing the group name in the input below
"Subgroups to Add" then by selecting the group from the suggested list. 

XWiki Enterprise comes with a new Group Picker which is used by default by all the XCLASS properties of type "List of
Groups". The new picker allows you to add multiple subgroups in one step. Similarly to the User Picker, the group alias is
the name of the group document, the group name is the title of the group document while the group avatar is the first image
attached to the group document. The process is the same as for global groups.

In order to toggle between the local and global scope, click on the globe icon. If you are in local scope, the icon will be ,

whereas in global scope, the icon will be . You can add both local and global subgroups by first choosing the corresponding
option in the drop-down list. After starting to type, if the subgroup exists, the suggest feature will display the list of all the group
names containing the typed letters. 
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Delete an User or a Subgroup From a Local Group

To remove an user or a subgroup from a local group, just click on the corresponding "X" icon in the "Manage" column. 

     

Related Pages

• User Guide
• User Status
• User Directory
• Registration

• Admin Guide
• Users and Groups Overview
• Set the Users Access Rights
• Set the Group Access Rights
• Manage the Sub-Wiki Users
• Edit a Global User
• Edit a Global Group
• Delete a Global User
• Delete a Global Group
• Create a Global User
• Create a Global Group
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LDAP Authentication
• Generic LDAP Configuration

• Enable LDAP Support
• Set Up LDAP
• Configure LDAP from the Administration Section
• LDAP Application
• Configuration Parameters

• Microsoft Active Directory
• Open Directory Server (OpenDS)
• Use Cases

• Reuse the LDAP Users Membership
• Users Belonging to Different Organization Units
• Users Located on Different Servers
• Having the LDAP users registered only on the main wiki

The advantage of using LDAP is that all the user and group information can be held on one server which is centrally managed.
This way, the user information doesn't have to be replicated.

Generic LDAP Configuration

Enable LDAP Support

In order to enable the LDAP support, you have to change the authentication method in the xwiki.cfg file as follows:

## Turn LDAP authentication on - otherwise only XWiki authentication
## 0 : disable
## 1 : enable
xwiki.authentication.ldap=1
## set LDAP as authentication service
xwiki.authentication.authclass=com.xpn.xwiki.user.impl.LDAP.XWikiLDAPAuthServiceImpl

Set Up LDAP

The LDAP configuration can be set up in the xwiki.cfg file as follows:

#-# LDAP Server (Active Directory, eDirectory, OpenLDAP, etc.)
xwiki.authentication.ldap.server=127.0.0.1
xwiki.authentication.ldap.port=389
#-# LDAP login, empty = anonymous access, otherwise specify full dn
#-# {0} is replaced with the username, {1} with the password
xwiki.authentication.ldap.bind_DN=cn={0},department=USER,department=INFORMATIK,department=1230,o=MP
xwiki.authentication.ldap.bind_pass={1}
#-# Force to check password after LDAP connection
#-# 0: disable
#-# 1: enable
xwiki.authentication.ldap.validate_password=0
#-# only members of the following group will be verified in the LDAP
#-# otherwise only users that are found after searching starting from the base_DN
# xwiki.authentication.ldap.user_group=cn=developers,ou=groups,o=MegaNova,c=US
#-# only users not member of the following group can autheticate
# xwiki.authentication.ldap.exclude_group=cn=admin,ou=groups,o=MegaNova,c=US
#-# base DN for searches
xwiki.authentication.ldap.base_DN=
#-# Specifies the LDAP attribute containing the identifier to be used as the XWiki name (default=cn)
# xwiki.authentication.ldap.UID_attr=cn
#-# Specifies the LDAP attribute containing the password to be used "when xwiki.authentication.ldap.validate_password" is
set to 1
# xwiki.authentication.ldap.password_field=userPassword
#-# The potential LDAP groups classes. Separated by commas.
# xwiki.authentication.ldap.group_classes=group,groupOfNames,groupOfUniqueNames,dynamicGroup,dynamicGroupAux,
groupWiseDistributionList
#-# The potential names of the LDAP groups fields containings the members. Separated by commas.
# xwiki.authentication.ldap.group_memberfields=member,uniqueMember
#-# retrieve the following fields from LDAP and store them in the XWiki user object (xwiki-attribute=ldap-attribute)
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xwiki.authentication.ldap.fields_mapping=last_name=sn,first_name=givenName,email=mail
#-# on every login update the mapped attributes from LDAP to XWiki otherwise this happens only once when the XWiki
account
is created.
xwiki.authentication.ldap.update_user=1
#-# mapps XWiki groups to LDAP groups, separator is "|"
# xwiki.authentication.ldap.group_mapping=XWiki.XWikiAdminGroup=cn=AdminRole,ou=groups,o=MegaNova,c=US|\
#                                         XWiki.Organisation=cn=testers,ou=groups,o=MegaNova,c=US
#-# time in s after which the list of members in a group is refreshed from LDAP (default=3600*6)
# xwiki.authentication.ldap.groupcache_expiration=21800
#-# - create : synchronize group membership only when the user is first created
#-# - always: synchronize on every login
# xwiki.authentication.ldap.mode_group_sync=always
#-# if ldap authentication fails for any reason, try XWiki DB authentication with the same credentials
xwiki.authentication.ldap.trylocal=1
#-# SSL connection to LDAP server
#-# 0: normal
#-# 1: SSL
# xwiki.authentication.ldap.ssl=0
#-# The keystore file to use in SSL connection
# xwiki.authentication.ldap.ssl.keystore=
#-# The java secure provider used in SSL connection
# xwiki.authentication.ldap.ssl.secure_provider=com.sun.net.ssl.internal.ssl.Provider

Configure LDAP from the Administration Section

You can configure LDAP by editing the "XWiki.XWikiPreferences" page in "Objects" mode as shown in the image below:
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LDAP Application

The LDAP Application available at http://extensions.xwiki.org/xwiki/bin/view/Extension/LDAP+Application provides the user
interface that allows you to easily configure LDAP. To install it, we recommended that you use the Extension Manager by
following the steps described in the dedicated documentation page. 

To access the LDAP administration section, go to the wiki preferences page and click on the "LDAP" link from the vertical
menu to the left.

In case you receive the warning message below, you will need to enable LDAP as explained in the above section.

The first drop-down list allows you to decide if LDAP authentication should be manually enabled on the wiki and it can be
used as a switch for the LDAP authentication.

http://extensions.xwiki.org/xwiki/bin/view/Extension/LDAP+Application
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In case you have already configured the LDAP connection in the XWiki configuration file, /WEB-INF/xwiki.cfg, you
can use the LDAP application to either override some settings or to fill in the ones that are missing in the configuration file. 

In order to communicate with your LDAP server, XWiki needs to know:

• The server address, either IP or domain name, and the port to connect to.
• A bind login and password to connect to the LDAP server, which can be left empty for anonymous access. In case you

need to use the username and password of XWiki users, you can enter {0} as placeholder for the user uid field, and {1}
for the password.
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The LDAP application also helps you configure users and groups mappings which means linking fields from the user profile
of the LDAP server to the ones from the XWiki user profile.
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Configuration Parameters
For the authentication to work as expected, the property xwiki.authentication.authclass must also be set in
xwiki.cfg to use the LDAP authenticator. 
Parameter xwiki.cfg analog Description

Ldap  xwiki.authentication.ldap Turn the LDAP authentication on - otherwise
only the XWiki authentication will be on

Ldap server address xwiki.authentication.ldap.server The LDAP Server (Active Directory,
eDirectory, OpenLDAP)

Ldap server port xwiki.authentication.ldap.port

Ldap login matching xwiki.authentication.ldap.bind_DN Empty means anonymous access, otherwise
you have to specify the full distinguished
name
{0} is replaced by the user name, {1} by the
password
The username and password could be
specified explicitly.

Ldap password matching xwiki.authentication.ldap.bind_pass It may be an explicit username and password
to access your LDAP directory.

Validate Ldap user/password xwiki.authentication.ldap.validate_password Bypass the standard LDAP bind validation by
doing a direct password comparison.

Ldap group filter xwiki.authentication.ldap.user_group Only the members of this group will be
verified in LDAP
Otherwise only the users that are found after
a search starting from the base_DN will be
verified
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Ldap group to exclude xwiki.authentication.ldap.exclude_group Only users not belonging to this group can
authenticate

Ldap base DN xwiki.authentication.ldap.base_DN The base DN for searches

Ldap UID attribute name xwiki.authentication.ldap.UID_attr Specifies the LDAP attribute containing the
identifier to be used as the XWiki name

Try local login xwiki.authentication.ldap.trylocal If the LDAP authentication fails for
any reason, it will try the XWiki DB
authentication with the same credentials

Update user from LDAP xwiki.authentication.ldap.update_user On every login, it will update the mapped
attributes from LDAP to XWiki.
Otherwise this happens only once when the
XWiki account is created.

Ldap user field mapping xwiki.authentication.ldap.fields_mapping Retrieve the following fields from LDAP and
store them in the XWikiUser object (xwiki-
attribute=ldap-attribute)

Ldap groups mapping xwiki.authentication.ldap.group_mapping Maps the XWiki groups to the LDAP groups,
separated by the "|" character.

Microsoft Active Directory
The properties that you need to set in the xwiki.cfg file are:

• ldap_server: the name or IP of the Active Directory server machine
• ldap_port: the port number (e.g. 389)
• ldap_base_DN: the name of the root DN (e.g. dc=ad,dc=company,dc=com)
• ldap_bind_DN: the domain{0} (e.g. ad{0} where {0} will be replaced by the username during validation)
• ldap_bind_pass:  {1} (where {1} will be replaced by the password during validation)
• ldap_UID_attr: sAMAccountName
• ldap_fields_mapping:

name=sAMAccountName,last_name=sn,first_name=givenName,fullname=displayName,email=mail,ldap_dn=dn

Example:
xwiki.authentication.authclass=com.xpn.xwiki.user.impl.LDAP.XWikiLDAPAuthServiceImpl
xwiki.authentication.ldap=1
xwiki.authentication.ldap.server=adserver
xwiki.authentication.ldap.port=389
xwiki.authentication.ldap.base_DN=dc=subdomain,dc=domain,dc=suffix
xwiki.authentication.ldap.bind_DN=subdomain{0}
xwiki.authentication.ldap.bind_pass={1}
xwiki.authentication.ldap.UID_attr=sAMAccountName
xwiki.authentication.ldap.fields_mapping=name=sAMAccountName,last_name=sn,first_name=givenName,fullname=displayName,
email=mail,ldap_dn=dn

Open Directory Server (OpenDS)
If you want to authorize only a member of a specific group to login in, you have to set the following properties:

xwiki.authentication.ldap.server=ldap.domain.tld
xwiki.authentication.ldap.port=389
xwiki.authentication.ldap.bind_DN=
xwiki.authentication.ldap.bind_pass=
xwiki.authentication.ldap.base_DN=ou=people,dc=domain,dc=tld
xwiki.authentication.ldap.UID_attr=cn
xwiki.authentication.ldap.group_classes=groupOfNames
xwiki.authentication.ldap.group_memberfields=memberUid
xwiki.authentication.ldap.user_group=cn=xwiki,ou=roles,dc=domain,dc=tld

In this case, the group is cn=xwiki,ou=roles,dc=domain,dc=tld.The properties bind_DN and bind_pass are
both empty, so the connection to the LDAP server will be anonymous. With OpenDS, an anonymous connection can read some
needed attributes like userPassword.
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Use Cases

Reuse the LDAP Users Membership

When a user logs in, all the other LDAP users from the same group can be automatically added to a XWiki group, by setting the
xwiki.authentication.ldap.group_mapping parameter as follows:

xwiki.authentication.ldap.group_mapping=XWiki.XWikiAdminGroup=cn=HMS Lydia,ou=crews,ou=groups,o=sevenSeas

In case you want to have more mappings, just add them separated by the | character:

xwiki.authentication.ldap.group_mapping=XWiki.XWikiAdminGroup=cn=HMS Lydia,ou=crews,ou=groups,o=sevenSeas|
                                        XWiki.OtherXWikiGroup=HMS Victory,ou=crews,ou=groups,o=sevenSeas

Users Belonging to Different Organization Units

Given that you cannot use a pattern like

xwiki.authentication.ldap.bind_DN=cn={0},department=USER,department=INFORMATIK,department=1230,o=MP

you have to connect to LDAP with a user able to list the LDAP users (or groups if you want to do a membership
synchronization). The LDAP authentication will automatically search for the user DN, trying to match the provided login with
the value of the xwiki.authentication.ldap.UID_attr attribute.

For example if you have an admin user with the DN cn=Administrator,dc=mydomain,dc=org and password pass,
you should do the following settings:

xwiki.authentication.ldap.bind_DN=cn=Administrator,dc=mydomain,dc=org
xwiki.authentication.ldap.bind_pass=pass

You can use any other LDAP user who has the right to search into the whole LDAP server. The LDAP authentication will use
it to connect to the LDAP server, will search for the provided user and will bind the found DN with the provided password in
order to validate it.

Users Located on Different Servers

If you use several sub-domains and the users are defined separately in each sub-domain, you will have a configuration like this:

sub1.somedomain.com
sub2.somedomain.com
sub3.somedomain.com
...

To configure the group membership login, you can make one (or more) group(s) in your Active Directory and set the group
membership to all users who need to access your wiki. Next, you have to configure XWiki so that only the members belonging
to this specific group have the right to log in. With this setting, XWiki will ignore the base_DN search, if a user is found in that
group. Note that the users will have to login using their full name instead of their username.

Having the LDAP users registered only on the main wiki

This is the case of a multi-wiki environment. Each wiki can have its own LDAP configuration set in the
XWiki.XWikiPreferences page. What you can find in the xwiki.cfg file is just the default LDAP configuration.

When the LDAP authenticator fails to authenticate against a wiki, it will try to authenticate against the main wiki.

In order to forbid LDAP authentication to create users on subwikis you have to edit the page 'XWiki.XWikiPreferences' in
"Objects" mode and:

• disable LDAP in xwiki.cfg and enable it in the main wiki by choosing Yes in the Ldap field
or

• disable LDAP in every sub-wiki by choosing No in the Ldap field

    

Related Pages

• User Guide
• XWiki Login
• User Profile
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Manage the Sub-Wiki Users
• The Sub-Wiki User Directory
• Add or Remove Users

• The Sub-Wiki Supports only Global Users
• The Sub-Wiki Supports only Local Users
• The Sub-Wiki Supports both Local and Global Users

• Create and Cancel Invitations
• The Sub-Wiki Supports only Global Users
• The Sub-Wiki Supports only Local Users
• The Sub-Wiki Supports both Local and Global Users

• Join Requests
• Accept a Join Request
• Reject a Join Request

In order to have the necessary privileges to manage the sub-wiki users, you need to either be its owner or an administrator.

The Sub-Wiki User Directory
The are 3 ways of accessing the users directory:

• by clicking on the "User Directory" link in the "Top Active Contributors" section from the wiki home page.

• by clicking on the "User Index" link in the "Applications" panel

• directly from the URL by navigating to the page "Main.UserDirectory"
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The User Directory displays sortable and filterable XWiki.XWikiUsers properties as columns. Any user can customize
his view over the User Directory livetable by adding or removing columns. To know more, go to the dedicated documentation
page listed in the "Related Pages" section.

In case you have configured your wiki to support both local and global users, the "User Scope" drop-down allows choosing
the sub-wiki members to display:

• global users i.e. main wiki users
• local users i.e. users created locally on the sub-wiki; this option is selected by default

Add or Remove Users
Hover the "Wiki" menu and click on "Administer Wiki".

In the sub-wiki preferences page, click on the "Users" link in the vertical menu to the left. Depending on the sub-wiki
configuration, you have 3 possibilities.
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The Sub-Wiki Supports only Global Users

If you have configured the sub-wiki to be accessible exclusively to global users, you will only be able to add users main wiki
users. To to so, fill in the user name and eventually a message which will be privately sent to the user, then click on "Add". After
starting to type the user name, if the user exists, the suggest feature will help by displaying the list of occurrences.

The new User Picker allows you to add multiple users at once. To remove one of them, just hover the corresponding user
name and click on the red "X" in the top right corner. In case you want to remove all the members at once, click on "Clear
selection".
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The new member(s) of the sub-wiki will appear in the "Current Members" livetable.

To remove a member, click on the corresponding "remove" link from the "Current Members" livetable.

The Sub-Wiki Supports only Local Users

For a sub-wiki accessible only to local users, the "Add or Invite Users to Wiki", "Current Members" and "Candidates" section
won't be displayed anymore. In exchange, you will see the old users overview which will display local users by default. 
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To create a local user, click on "Add New User", fill in the required information in the registration form, then click on "Save".
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The Sub-Wiki Supports both Local and Global Users

For a sub-wiki that is accessible for its local users as well as for global users, you can add main wiki users by filling in the user
name (and eventually a message which will be privately sent to the user) and clicking the "Add" button. 
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Existing local users are already displayed in the "Current Members" livetable. To add a new local user, you need to create it
using the "Add New User" button and he/she will be automatically added to the "Current Members" livetable.

Create and Cancel Invitations
The "Invite User" feature is mostly used in an "invitation-only" sub-wiki but it is not restricted to that. Any global user can be
invited, regardless of the wiki membership type. 

Go to the wiki administration page and click on the "Users" link in the vertical menu to the left. Similarly to the Add User
feature, there are 3 possible cases.

The Sub-Wiki Supports only Global Users

If the sub-wiki is accessible exclusively to global users, you will only be able to invite them by filling in the user name and
eventually a message viewable by the user, then clicking the "Invite" button. 

Just like in the above section, you can invite several users at once. If the operation is successful, you will see a confirmation
message

and also new entries in the "Candidates" section to the bottom of the page.
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The invitation template contains information about the invited user, the status and type of the request and the name of
the user who has made the invitation. The administrator's message will be viewable in the Activity Stream of the wiki along
with the date of the invitation. The "Private Comment" is meant for the wiki administrators and its purpose is to provide a
justification for inviting the user.

Once the user accepts the invitation, you will notice a change of status in the "Candidates" section.

The same thing happens if an user rejects the invitation.

To cancel an invitation, go to the wiki administration page and click on the "Users" link in the vertical menu to the left. In the
"Candidates" section, click on the corresponding "Cancel Invitation" button. If successful, you will see a confirmation message.
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The cancellation message will be visible in the Activity Stream of the wiki.

The Sub-Wiki Supports only Local Users

For a sub-wiki accessible only to local users, the "Invite User" feature is not available because it was meant for inviting global
users.

The Sub-Wiki Supports both Local and Global Users

For a sub-wiki that is accessible for its local users as well as for global users, you can invite main wiki users by filling in the user
name (and eventually a message which will be privately sent to the user) and clicking the "Invite" button. The process is the
same as for a sub-wiki that only supports global users. 

Join Requests

Accept a Join Request

If you are the owner or an administrator, go to the wiki administration page and click on the "Users" link in the vertical menu to
the left. In the "Candidates" section, click on the corresponding "Accept" button. You can also add a message in the "Admin's
Message" text-box which will be privately sent to the requesting user as a reply. The "Private Comment" is meant for the wiki
administrators and its purpose is to provide a justification for the acceptance of the request.

If successful, you will see a confirmation message to the top of the page. In the "Candidates" section, the status of the user
request will become "Accepted" and you will also be able to see the administrator's message.
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Reject a Join Request

If you are the owner or an administrator, go to the wiki administration page and click on the "Users" link in the vertical menu
to the left. In the "Candidates" section, click on the corresponding "Reject" button. You can also add a message in the "Admin's
Message" text-box which will be privately sent to the requesting user as a reply. The "Private Comment" is meant for the wiki
administrators and its purpose is to provide a justification for the rejection of the request.

If successful, you will see a confirmation message to the top of the page. In the "Candidates" section, the status will become
"Rejected" and you will also be able to see the Administrator's message.

     

Related Pages

• User Guide
• XWiki Syntaxes
• View the List of Joined Sub-Wikis
• User Directory
• Sub-Wiki Invitations
• Leave a Sub-Wiki
• Join a Sub-Wiki
• Editing Modes

• Admin Guide
• Wiki Directory
• The Wiki Manager Application
• The Management of Global/Local Users and Groups
• Set the Wiki Access Rights
• Set the Users Access Rights
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• Edit the Sub-Wiki Settings
• Edit a Global User
• Delete a Sub-Wiki
• Delete a Global User
• Create a Sub-Wiki
• Create a Global User



XWiki Enterprise 5.4.4 Admin Guide

Page 84

Rights Overview

FAQ
How do I set the access rights for the whole wiki?
How do I set the access rights for a sub-wiki?
How do I set the access rights for spaces?
How do I set the access rights for pages?
How do I set the access rights for global groups?
How do I set the access rights for local groups?
How do I set the access rights for global users?
How do I set the access rights for local users?
What are the different permission types?
How do I use rights to configure access on the wiki?

Set the Wiki Access Rights
• Set the Main Wiki Access Rights
• Set the Sub-Wiki Access Rights
• Default Values for Rights at Main Wiki Level
• Default Values for Rights at Sub-wiki Level

Set the Main Wiki Access Rights
To change rights for the main wiki, log in as administrator, hover the "Home" menu and click on "Administer Wiki".

In the wiki administration page, click on the "Rights" link from the vertical menu to the left. 
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Next, select the users or groups for which you want to set a permission. Note that if you are on the main wiki, you are editing
the rights for global users and groups. To know more about the difference between local and global users and groups, follow this
link.

Click once on a check-box to allow a right, twice to deny it and three times to clear the right and use the default values. Note
that rights entries are saved automatically.

More information about permission types are available in the dedicated documentation page.

Set the Sub-Wiki Access Rights
To change rights for a sub-wiki, log in as administrator, hover the "Wiki" menu and click on "Administer Wiki".

In the wiki preferences page, click on the "Rights" link in the vertical menu to the left.
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Select the local or global groups and users for which you want to set a permission.

Click once on a check-box to allow a right, twice to deny it and three times to clear the right and use the default values. Note
that rights entries are saved automatically.

Default Values for Rights at Main Wiki Level
When a right has been allowed at a given level, it gets explicitly denied to anyone else at the same level.
 Wiki Right  Default Value  Comments

VIEW ALLOWED

EDIT ALLOWED EDIT rights at wiki level also imply VIEW
rights

COMMENT ALLOWED

DELETE DENIED

REGISTER ALLOWED

ADMIN DENIED • ADMIN rights at wiki level also
imply the VIEW, EDIT, COMMENT,
DELETE and REGISTER rights.
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• If ADMIN rights are granted at wiki
level, they cannot be denied at a lower
level (space or page).

• The rights implied by ADMIN rights
will not be overridden by a denial at a
lower level.

PROGRAM DENIED • Programming rights can only be set in
the main wiki.

• PROGRAMMING rights at wiki level
also imply VIEW, EDIT, COMMENT,
DELETE, REGISTER and ADMIN
rights.

• If PROGRAMMING rights are
granted at wiki level, they cannot
be denied at a lower level (space or
page)    

CREATE WIKI DENIED The rights to create wiki can only be granted
via the main wiki.

Default Values for Rights at Sub-wiki Level
When a right has been allowed at a given level, it gets explicitly denied to anyone else at the same level.
 Wiki Right  Default Value  Comments

VIEW ALLOWED

EDIT ALLOWED EDIT rights at wiki level also imply VIEW
rights

COMMENT ALLOWED

DELETE DENIED

ADMIN DENIED • ADMIN rights at wiki level also imply
the VIEW, EDIT, COMMENT and
DELETE rights.

• If ADMIN rights are granted at wiki
level, they cannot be denied at a lower
level (space or page).

• The rights implied by ADMIN rights
will not be overridden by a denial at a
lower level.

  

Related Pages

• User Guide
• XWiki Syntaxes
• View the List of Joined Sub-Wikis
• Sub-Wiki Invitations
• Leave a Sub-Wiki
• Join a Sub-Wiki
• Editing Modes

• Admin Guide
• Wiki Types
• Wiki Directory
• The Wiki Manager Application
• Set the Users Access Rights
• Set the Space Access Rights
• Set the Page Access Rights
• Set the Group Access Rights
• Rights Overview
• Permission Types
• Manage the Sub-Wiki Users
• Edit the Sub-Wiki Settings
• Delete a Sub-Wiki
• Customize the User Registration Process
• Create a Sub-Wiki
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Set the Space Access Rights
There are 3 ways of setting the space access rights:

• Hover the "Home" menu for the main wiki

 

or the "Wiki" menu for a sub-wiki and click on "Administer Wiki" .

Use the drop-down list to access the administration pages of the existing spaces

• Hover the "Space" menu and click on "Administer Space".
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• Go to the main home page or to "Main.Spaces", hover the space name and click on the wrench icon.

In the space preferences page, click on the "Rights" link from the vertical menu to the left.

Click once on a check-box to allow a right, twice to deny it and a third time to clear the right and use the default values. Note
that rights entries are saved automatically.
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More information about the permission types are available in the dedicated documentation page.

Default Values for Rights at Space Level
When a right has been allowed at a given level, it gets explicitly denied to anyone else at the same level.
 Wiki Right  Default Value  Comments

VIEW ALLOWED

EDIT ALLOWED EDIT rights at space level also imply VIEW
rights

COMMENT ALLOWED

DELETE DENIED

ADMIN DENIED • ADMIN rights at space level also
imply the VIEW, EDIT, COMMENT
and DELETE rights.

• The rights implied by ADMIN rights
will not be overridden by a denial at a
lower level.

 

Related Pages

• User Guide
• Watch a Space
• Index Application
• Editing Modes
• Create and Delete a Space

• Admin Guide
• Set the Wiki Access Rights
• Set the Users Access Rights
• Set the Page Access Rights
• Set the Group Access Rights
• Rights Overview
• Permission Types
• Pages and Spaces Overview
• Customize the User Registration Process
• Create a Sub-Wiki
• Create a Space Template
• Create a Page Template
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Set the Page Access Rights
To edit access rights for a page, simply navigate to that page, hover the "Edit" menu and click on "Access Rights".

On the Rights page, click once on the check-box to grant a right, twice to deny it and a third time to clear the right and use the
default values. Note that rights entries are saved automatically.

More information about permission types are available in the dedicated documentation page.

Default Values for Rights at Page Level
When a right has been allowed at a given level, it gets explicitly denied to anyone else at the same level.
 Wiki Right  Default Value  Comments

VIEW ALLOWED

EDIT ALLOWED EDIT rights at page level also imply VIEW
rights

COMMENT ALLOWED

DELETE DENIED

Related Pages

• User Guide
• Editing Modes

• Admin Guide
• Set the Wiki Access Rights
• Set the Users Access Rights
• Set the Space Access Rights
• Set the Group Access Rights
• Rights Overview
• Permission Types
• Customize the User Registration Process
• Create a Sub-Wiki
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Set the Group Access Rights
• Set the Rights for Global Groups at Wiki Level
• Set the Rights for Local Groups at Wiki Level
• Set the Group Access Rights at Space or Page Level

Set the Rights for Global Groups at Wiki Level
Global groups are created on the main wiki and any rights granted to them will also apply for the sub-wikis.

You might need to grant explicit rights for global groups on a sub-wiki in one of the following cases:

• the wiki only has global users
• the wiki has both global and local users

This configuration option is set when creating the wiki, but it can be easily changed at a later time. 

To set the access rights for a global group, you need to be a wiki administrator or the wiki owner. Hover the "Home" menu
for the main wiki 

or the "Wiki" menu for a sub-wiki and click on "Administer Wiki".

In the wiki administration page, click on the "Rights" link in the vertical menu to the left to bring up an overview of group
rights.
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On a sub-wiki, the livetable displays the local groups by default, so you will need to switch to "Global" in the "Search scope":

Click the check-box once to grant a right, twice to deny it and three times to clear the right and use the default values. Note
that rights entries are saved automatically.
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Set the Rights for Local Groups at Wiki Level
The access rights for local groups can only be set on the sub-wiki they were created on. Local groups are created on sub-wikis
that support:

• only local users
• both local and global users

To set the access rights for local groups, go to a sub-wiki and log in as administrator. Next, hover the "Wiki" menu and click
on "Administer Wiki" to go to the administration page.

Click on the "Rights" link in the vertical menu to the left to bring up an overview of group rights.

Click the check-box once to grant a right, twice to deny it and three times to clear the right and use the default values.
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Set the Group Access Rights at Space or Page Level
In order to set the access rights only for a page or a space, follow the documentation indicated in the "Related Pages" section.

The rights for a page override the rights for a space, which override the rights for a wiki.  Also, when a right has been allowed at
a given level, it gets explicitly denied to anyone else at the same level. 

You can read about permission types on the dedicated documentation page. Also, to learn more about the local and global
groups, please follow this link.

   

Related Pages

• User Guide
• Editing Modes

• Admin Guide
• Users and Groups Overview
• The Management of Global/Local Users and Groups
• Set the Wiki Access Rights
• Set the Users Access Rights
• Set the Space Access Rights
• Set the Page Access Rights
• Rights Overview
• Permission Types
• Edit a Global Group
• Delete a Global Group
• Customize the User Registration Process
• Create a Sub-Wiki
• Create a Global Group
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Set the Users Access Rights
• Set the Rights for Global Users at Wiki Level
• Set the Rights for Local Users at Wiki Level
• Set the Users Access Rights for a Space or a Page

Set the Rights for Global Users at Wiki Level
Global users are created on the main wiki and the rights granted there will also apply for the sub-wikis. 

You might need to grant explicit rights for global users on a sub-wiki in one of the following cases:

• the wiki only has global users
• the wiki has both global and local users

This configuration option is set when creating the wiki, but it can be easily changed at a later time. 

To set the rights for a global user you need to have administration rights or to be the owner of the wiki. Hover the "Home"
menu for the main wiki 

or the "Wiki" menu for a sub-wiki and click on "Administer Wiki".

Next click on the "Rights" link in the vertical menu to the left.
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In the table header, click on the "Users" radio button to bring up an overview of user rights.

On a sub-wiki, the livetable displays the local users by default, so you will need to switch to "Global" in the "Search scope":
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Finally, click the check-box once to grant a right, twice to deny it and three times to clear the right and use the default values.
Rights entries are saved automatically.
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Set the Rights for Local Users at Wiki Level
Local users are created on each sub-wiki that supports:

• only local users
• both local and global users

To set the access rights for local users go to a sub-wiki and log in as administrator. Next, hover the "Wiki" menu and click on
"Administer Wiki" to go to the administration page. 

Click on the "Rights" link in the vertical menu to the left.

 

In the table header, check on the "Users" radio button to bring up an overview of user rights.
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Finally, click the check-box once to grant a right, twice to deny it and three times to clear the right and use the default values.

Set the Users Access Rights for a Space or a Page
In order to set the access rights only for a page or a space, follow the documentation indicated in the "Related Pages" section.

The rights for a page override the rights for a space, which override the rights for a wiki.  Also, when a right has been allowed at
a given level, it gets explicitly denied to anyone else at the same level. 

You can read about permission types on the dedicated documentation page. Also, to learn more about the local and global
users, please follow this link.

   

Related Pages

• User Guide
• User Status
• User Directory
• Registration
• Editing Modes

• Admin Guide
• Users and Groups Overview
• The Management of Global/Local Users and Groups
• Set the Wiki Access Rights
• Set the Space Access Rights
• Set the Page Access Rights
• Set the Group Access Rights
• Rights Overview
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• Manage the Sub-Wiki Users
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Permission Types
• View Right
• Comment Right
• Edit Right
• Delete Right
• Special Permissions

• Administration Rights
• Programming Rights
• Register Rights
• Create Wikis Rights

View Right
The view right gives the user the ability to view a document or load it using the API.

• Availability: Page, Space and Wiki level.
• Default status: ALLOWED
• Priority order: deny > allow > no setting
• Checking order: page > space > wiki

Comment Right
The comment gives the user the ability to add a comment, but not to edit or delete it.

• Availability: Page, Space and Wiki level.
• Default status: ALLOWED
• Priority order: deny > allow > no setting
• Checking order: page > space > wiki

In order to be able to edit or delete your own comments, you need to have edit rights on the space or page. Also, you won't be
able to edit or delete the comments of other users, unless you have administration rights.

Edit Right
The edit allows you to edit the page and all of its objects.

• Availability: Page, Space and Wiki level.
• Default status: ALLOWED
• Priority order: deny > allow > no setting
• Checking order: page > space > wiki

Delete Right
The delete right allows you to move a page to the recycle bin.

• Availability: Page, Space and Wiki level.
• Default status: DENIED (unless you're the document creator)
• Priority order: deny > allow > no setting
• Checking order: page > space > wiki

Special Permissions

Administration Rights

The administration right can only be granted at space or wiki level. A very important detail is that the wiki administrator cannot
have his/her administration rights denied for a space. Also, having administration rights imply the view, comment, edit and
delete permissions with the added ability to permanently delete a page from the recycle bin.

• Availability:
• Space (Automatically includes the view, comment, edit, delete rights)
• Wiki (Automatically includes the view, comment, edit, delete, register, program rights)

• Default status: DENIED
• Priority order: allow > deny > no setting
• Checking order: wiki > space
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Programming Rights

A programmer is allowed to execute arbitrary Java code in the wiki, so any page which was last saved by an user with
programmer rights can run dangerous scripts. Because it affects the entire wiki (or wiki farm), programming rights can only be
granted from the wiki preferences page in a single wiki environment or from the main wiki in a multi-wiki environment.

• Availability: Main wiki level
• Default status: DENIED
• Priority order: allow > deny > no setting
• Checking order: wiki

Register Rights

The register right is usually granted or revoked for the non-registered pseudo-user "XWiki.XWikiGuest". This permission can
only be set from the wiki preferences page.

• Availability: Wiki level
• Default status: ALLOWED
• Priority order: allow > deny > no setting
• Checking order: wiki

Create Wikis Rights

The "createwiki" right can only be granted via the main wiki, just like programming rights. For detailed information, check this
documentation page.

• Availability: Main wiki level
• Default status: DENIED
• Priority order: allow > deny > no setting
• Checking order: wiki

Related Pages

• User Guide
• Editing Modes

• Admin Guide
• Set the Wiki Access Rights
• Set the Users Access Rights
• Set the Space Access Rights
• Set the Page Access Rights
• Set the Group Access Rights
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• Create a Sub-Wiki
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Customize the User Registration Process
You can configure your Wiki to be open, so that everyone can edit or comment without having to register or to log in. To do
this, simply grant the "view" and "comment" rights to the pseudo-user named XWiki.XWikiGuest.

In order to require users to confirm their registration and to provide a valid email address, hover the "Home" menu and click on
"Administer Wiki". In the wiki preferences page, click on the "Registration" link from the vertical menu to the left.

Next, set "Use email verification" to "YES" which means that an email will be sent to the email address the user registered with.
The "Authentication Active Check" option set to "YES" will prevent the users from logging in without entering the token which
was previously sent by email. The content of the message is set in the "Validation E-Mail Content" text area.
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Registration Options
• Registration page heading is the line displayed at the top of the page for the users who are registering or who have just

registered.

• Confirmation E-Mail Content requires that you set "Use email verification" and "Authentication Active Check" to
"YES". These settings are optional but you will still have to provide a link to activate the account.
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• Welcome Message requires that you set "User email verification" to "YES" and modify the "Validation E-Mail Content"
so that it doesn't mention the verification since it is not needed anymore.

• Enable Javascript field validation enables or disables the LiveValidation. Note that if this option is set to "FALSE", the
fields will still be validated server-side.

• Default field okay message refers to the message displayed by the LiveValidation when the fields have been correctly
filled in.

• Enable login button enables or disables the button the users need to click on in order to log in.

• Enable automatic login is disabled by default. If enabled, the user is automatically logged in after a successful
registration.
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• Redirect here after registration refers to the URL of the wiki page the user will be redirected to after clicking the
"Login" button.

• Require captcha to register requires the user to solve a CAPTCHA in order to register.

• Registration Successful Message is displayed when the user has successfully registered.

More details about the registration page are available by navigating to XWiki.RegistrationHelp.
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Panels Overview
A Panel is a menu that allows various actions in the wiki: navigation, search, page creation, statistics display. Panels generally
contain clickable links which are written manually or are automatically generated by scripts.

A full set of Panels is available by default, designed for main uses, but it is possible to create new Panels for specific needs.

Panels can be placed in various positions within your wiki interface: columns on the right, on the left, or both.

FAQ
How do I create a panel?
How do I make a panel visible on the entire wiki?
How do I make a panel visible on a specific space?
How do I display a panel only for a certain page?
How do I set the page layout for panels?
How do I set the panel columns to display?
How do I delete a panel?

Create a Panel
To create a panel, navigate to ServerName/xwiki/bin/view/Panels/WebHome or hover the "Home" menu for the main wiki 

and the "Wiki" menu for a sub-wiki and click on "Administer Wiki".

In the wiki administration page, click on the "Panel Wizard" link from the vertical menu to the left.
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Go to the bottom of the Panel Wizard administration page and click on "Go to Panels Home Page".

In the Panels home page fill in the name of your new panel then click on "Create".

A new page will open in "Inline" mode so that you can continue the panel creation by filling in the corresponding fields.
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Finalize the process by saving the page.
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Display a Panel
• Display a Panel on the Entire Wiki
• Display a Panel on a Specific Space
• Modify the Page Layout

Display a Panel on the Entire Wiki
To display a panel on the entire wiki, you need to access the Panel Wizard from the wiki administration page. One way of doing
this is by navigating to the Panels home page (ServerName/xwiki/bin/view/Panels/WebHome). Next, scroll down to the end of
the section "Viewer panels" until you see an information message with a magic wand icon saying "You can customize the side
column(s) using the Panel Wizard". Click on the link and you are done.

The second possibility is to hover the "Home" menu for the main wiki

or the "Wiki" menu for a sub-wiki and to click on "Administer Wiki".

In the wiki preferences page, click on the "Panel Wizard" link,
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select the Panel you wish to use from the "Panel List" tab,

drag the panel from the "Panel List",
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and drop the panel into the panels area.

Don't forget to scroll to the bottom of the page and click on "Save the New Layout" after you are done.

If you now go to any wiki page you will be able to see the panel in the same area you dropped it in.
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Display a Panel on a Specific Space
In case you want to display a panel only on a specific space, you will have to access its Panel Wizard. To do so, go to any page
of that space, hover the "Space" menu and click on "Administer Space".

Next, click on the "Panel Wizard" link from the vertical menu to the left and follow the steps described in the above section.

Modify the Page Layout
By default, only the right panel column is displayed in the wiki pages. In order to customize the page layout, follow the
dedicated documentation page.
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Display a Panel on a Specific Page
Panels can be configured to be displayed on all the wiki by using the Panel Wizard from the wiki preferences page. It is also
possible to display a panel on a specific space by using the Panel Wizard from the space web preferences page.

In order to display a panel only on a given page, you have 2 possibilities. In case you don't need to further customize the look
& feel of the panel, i.e. use the default skin and color theme, you can use the {{panel /}} macro as follows:

{{panel title="My Panel"}}
Content of the panel.
{{/panel}}

Note that you can place any XWiki content in the content of the panel. Also, the title parameter is optional.

If in return you want to use a custom CSS, one solution would be to use the panelheader and panelfooter Velocity
macros, then to define CSS rules for the .panel class as shown in the "Skins Extensions" tutorial. So, the code

{{velocity}}
#panelheader('My panel')
Some panel content
#panelfooter()
{{/velocity}}

will display the panel in the image below:

Other available Velocity macros which are distributed with a standard XWiki Enterprise instance are:

• #largepanelheader($title)
• #hiddenpanelheader($title)
• #largepanelfooter()
• #hiddenpanelfooter()
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Panels Layout
• Modify the Panels Layout from the "Panel Wizard" section
• Modify the Panels Layout from the "Page Elements" section

• Control the Panels Visibility
• Control the Document Metadata Visibility

Modify the Panels Layout from the "Panel Wizard" section
To set the panels layout for the whole wiki, hover the "Home" menu for the main wiki

or the "Wiki" menu for a sub-wiki and click on "Administer Wiki".

In the wiki preferences page, click on the "Look & Feel" icon, then on "Panel Wizard"
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or click on the "Panel Wizard" link from the vertical menu.

Click on the "Page Layout" tab, select one of the different layouts and you will be able to preview the new page layout instantly.
Provided you decide to keep the changes, click on "Save the New Layout".
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To set the panels layout for a space, hover the "Space" menu and click on "Administer Space".

In the space preferences page, click on the "Panel Wizard" link from the vertical menu to the left and follow the steps
described in the above paragraphs.

Modify the Panels Layout from the "Page Elements" section
Hover the "Home" menu for the main wiki or the "Wiki" menu for a sub-wiki and click on "Administer Wiki". In the
preferences page, click on the link "Page Elements" from the vertical menu to the left.

Control the Panels Visibility

If you take a look at the "Panels" section you will notice that by default only the right column is displayed. Also, any panel you
drag & drop from the "Panel Wizard" will be listed in the "Panels Displayed on the Left/Right" text-boxes. In case you already
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know the name of the panels you wish to be displayed and you don't want to use the Panel Wizard, you may specify them here
in a coma-separated list, as you can see in the image below.

After you made your changes, don't forget to scroll to the bottom of the page and click on the "Save" button.

Control the Document Metadata Visibility

You can control whether to display or not the "Comments", "History", "Attachments" and "Information" sections by enabling or
disabling the corresponding drop-down menus in the "Document Metadata Visibility" section.
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Delete a Panel
To access the Panels home page, navigate to ServerName/xwiki/bin/view/Panels/WebHome or hover the "Home" menu for the
main wiki 

and the "Wiki" menu for a sub-wiki and click on "Administer Wiki".

In the wiki preferences page, click on the "Panel Wizard" link from the vertical menu to the left.

At this point you have 2 options: you may either search the panel in the Panel Wizard and click on the "Delete" link located
below
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or you may go to the bottom of the Panel Wizard administration page and click on "Go to Panels Home Page".

On the panels home page you will see the list of all available panels. Scroll to the panel you wish to delete and click on the
corresponding "Delete" link.
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Customization Overview

FAQ

Skin and Color Themes

How do I create a color theme?
How do I edit a color theme?
How do I switch to another color theme?
How do I change the wiki logo?

User Profile

How can I choose which sections to display in my user profile?
How can I add a section to my user profile?
How can I remove a section from my user profile?

User Preferences

How do I change the preferences for the WYSIWYG editor?
How do I configure annotations?
How do I disable the message stream?

Localization

How to set the timezone for the whole wiki?
How do I set up the languages available in the wiki
How do I define a translation document?

XWiki Bundled Applications

Which are the default XWiki Enterprise applications?
What is Extension Manager?
How do I access the list of installed extensions?
How to install an extension?
How to upgrade an extension?
How do I downgrade an extension?
How to uninstall an extension?
How do I check for the outdated extensions?
How do I easily create a web application in my wiki?
How do I translate my web application?

Search Engines and Search Suggest Sources

How to set the default search engine?
How to customize the Solr index?
How do I debug Solr queries?
How to customize the Lucene index?
How to disable the search suggest?
How do I choose the search engine used by the search suggest?
How do I edit a search suggest source?
How do I add a search suggest source?
How do I delete a search suggest source?

Other Advanced Configurations

How do I configure the Open Office server?
How do I configure a SMTP server for the Watchlist and Share Page By Email features?

XWiki Applications
An application is a self-contained set of XWiki pages that offers a powerful way to create advanced content within wiki pages.
These pages can be exported into a single archive file named a XAR which can be imported again into other wikis. 
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XWiki Bundled Applications

 Scheduler Application
Allows scheduling jobs.

 Statistics Application
Provides various panels and pages displaying wiki related statistics.

 Office Importer Application
Imports office documents into wiki pages. The documentation page is available in the User Guide.

 Administration Application
Allows to administrate an XWiki Enterprise instance.

 Invitation Application
Allows users to send emails, inviting friends and colleagues to join a wiki.

 Wiki Macro Bridge Application
Allows creating XWiki macros through wiki pages.

 Tag Application
Tag pages with keywords and navigate your wiki using these keywords. The documentation page is available in the User Guide.

 Webdav Application
Allows editing attachments through WebDAV.

 Search Application
Allows searching on the full wiki using wildcards, searching by space, getting search result RSS feeds and more. The
documentation page is available in the User Guide.

 Lucene Search Application
Allows searching on the wiki using Apache Lucene. The documentation page is available in the User Guide.

 Solr Search Application
Allows searching on the wiki using Apache Solr. The documentation page is available in the User Guide.

 Color Theme Application
Allows fast and easy modifications of your wiki "look and feel".

 Annotations Application
Annotation User Interface. The documentation page is available in the User Guide.

 Watchlist Application
Subscribe to pages, spaces and wikis and receive RSS and email notifications when they are modified. The documentation page
is available in the User Guide.

 Panels Applications
Provides placeholders to put content located or right of the page's content.

 Blog Application
Transforms the wiki into a "bliki" with the ability to add Blog posts and display them. The documentation page is available in
the User Guide.

 Extension Manager Application
Used to install, update or remove extensions in/from the wiki.

 Application Within Minutes
Helps you create collaborative web applications within minutes, based on XWiki's powerful structured data management system.

 Dashboard Application

http://extensions.xwiki.org/xwiki/bin/view/Extension/Scheduler+Application
http://extensions.xwiki.org/xwiki/bin/view/Extension/Administration+Application
http://extensions.xwiki.org/xwiki/bin/view/Extension/Invitation+Application
http://extensions.xwiki.org/xwiki/bin/view/Extension/Wiki+Macro+Bridge+Application
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Provides Wiki and User Dashboards. The documentation page is available in the User Guide.

 Link Checker Application
Displays states of external links found in the wiki.

 Index Application
Displays an index of all documents, attachments, orphans, deleted items in the wiki. The documentation page is available in the
User Guide.

 Logging Application
An application to review and manipulate XWiki logs.

 User Application
Displays User Profiles and controls the user preferences, dashboard, watchlist.

 User Directory Application
Displays a directory of all users in the wiki. The documentation page is available in the User Guide.

 Help Application
Provides help within your wiki with xwiki syntaxes and customizing the registration process.

 Wiki Application
An XWiki application for creating and managing wikis.

You can find all XWiki applications on the xwiki.org website.

Configure the Office Server
• Configure OpenOffice as an Internally Managed Server Process

• The Local Office UI
• Configure Office as an Externally Managed Server Process
• The Auto Start Feature

There are two ways of configuring an Office server:

• as an internally managed process which is the default option
• as an externally managed process

Configure OpenOffice as an Internally Managed Server Process
By choosing the default configuration for OpenOffice, you allow your XWiki Enterprise installation to manage the OpenOffice
server process for you. Moreover, there is an UI available in the wiki preferences page allowing you to start, stop or restart the
Office server. 

The Local Office UI

To get to the Office Server administration section, hover the "Home" menu for the main wiki

http://extensions.xwiki.org/xwiki/bin/view/Extension/Link+Checker+Application
http://extensions.xwiki.org/xwiki/bin/view/Extension/Logging+Application
http://extensions.xwiki.org/xwiki/bin/view/Extension/User+Application
http://extensions.xwiki.org/xwiki/bin/view/Extension/Help+Application
http://extensions.xwiki.org/xwiki/bin/view/Main/WebHome#|t=extensions&p=5&l=30&s=doc.creationDate&d=desc&name=application&type=
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or the "Wiki" menu for a sub-wiki and click on "Administer Wiki".

In the wiki preferences page, click on the "Office Server" link in the vertical menu to the left.

You will then see the UI of your internally managed Office server,
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along with the 3 available actions to an administrator:

• start the server
• restart the server
• stop the server

Configure Office as an Externally Managed Server Process
This information only concerns the system administrators. 

Having an externally managed server process means that the system administrator has full control on the Office server process.
First of all, you need to edit the xwiki.properties file and set the openoffice.serverType parameter to 1. Next,
the Office server needs to be manually started as a separate process by running the following command in the terminal, into the
"program" directory where you installed "OpenOffice.org":

soffice -headless -accept="socket,host=127.0.0.1,port=8100;urp;" -nofirststartwizard

After restarting Tomcat, you will notice a change in the Office Server administration page, because this time you will only have
2 available actions:

• connect to the server
• disconnect from the server



XWiki Enterprise 5.4.4 Admin Guide

Page 129

The Auto Start Feature
In order to use the auto start feature, edit the xwiki.properties file and set the openoffice.autoStart parameter
to true as shown below:

#-# [Since 1.9M2]
#-# If the openoffice server should be started / connected upon XE start.
#-# Default value is false
# openoffice.autoStart=true
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Configure SMTP Server
If you are using the "Watchlist" and "Share page by email" features, you will need to configure a SMTP server and specify the
default email address that XWiki will use. To do this, hover the "Home" menu for the main wiki

or the "Wiki" menu for a sub-wiki and click on "Administer Wiki".

In the wiki administration page, click on the "Email" link from the vertical menu to the left.

Fill in the fields in the "General Settings" and "SMTP" sections, as shown in the image below:
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The SMTP server should be like mail.yourdomain.com and the SMTP server username must be the one specified in the
"Admin Email" field.

The "Obfuscate Email Addresses" option allows you to enable or disable the obfuscation of the email addresses that are
stored in object properties of type Email. This way, only the first letter of the email account will be displayed and the rest of the
letters will be replaced by an ellipsis like for instance a...@domain.org. 

You might need to specify some additional JavaMail properties. The most common are:

• mail.smtp.starttls.enable: if set to true, this parameter enables the use of the STARTTLS command (if
supported by the server) to switch the connection to a TLS-protected connection before issuing any login commands.
Note that an appropriate trust store must be configured so that the client trusts the server's certificate.

• mail.smtp.auth: if set to true, the server will authenticate the user using the AUTH command.

• mail.smtp.localhost: this is the local host name used in the SMTP HELO or EHLO command. The default value
is InetAddress.getLocalHost().getHostName().

An example of configuration of these 3 parameters is shown below:

For the complete list of parameters, please consult the JavaMail API.

http://javamail.kenai.com/nonav/javadocs/com/sun/mail/smtp/package-summary.html
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The Google SMTP Server
If you are using the Google SMTP server the fields in the "Email" section should be filled in as follows:

• Server: smtp.google.com
• Port: 587
• User: martin.charles@gmail.com
• Additional JavaMail properties: mail.smtp.starttls.enable=true

Related Pages

• User Guide
• XWiki Watchlist Application
• Share Page by Email

• Admin Guide
• Customization Overview
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Color Theme Application
• Create a Color Theme
• Edit a Color Theme
• Use a Color Theme

Create a Color Theme
To create a color theme, you first need to access the "Color Themes" home page, by hovering the "Home" menu for the main
wiki

and the "Wiki" menu for a sub-wiki and clicking on "Administer Wiki".

In the wiki administration page, click on the "Presentation" link from the vertical menu to the left.

In the "Color Themes" section, click on "Manage color themes".
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Next, on the Color Themes home page go to the "Other available themes" section, fill in the new theme name and click on
"Create new theme".

A new gray theme will appear in edit mode.

You can easily customize this theme to your liking but don't forget to save it once you are done.
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Edit a Color Theme
Color Themes can be changed in order to easily improve your wiki Look & Feel. To access the "Color Themes" home page,
navigate to ColorThemes.WebHome or hover the "Home" menu for the main wiki and the "Wiki" menu for a sub-wiki and click
on "Administer Wiki". Next, in the global administration page, click on the "Presentation" link from the vertical menu to the
left.

The first possibility is to select the color theme from the drop-down list in the "Color Themes" section, then to click on
"Customize".

The second way is to click on "Manage color themes".
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Next, click on a theme you would like to customize

and edit the theme page in "Inline" mode.
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Hover the area you would like to change. Should you hover the palette in the top right corner, a pop-up will appear listing
everything you can customize at this level. By clicking it, a dialog will appear so that you can start making changes.

You can also replace the XWiki logo with another image attached to the color theme page. To do so, hover the logo and click on
the pallet in the bottom left corner.
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Next, fill in the attachment name, save the page and you are done.
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Use a Color Theme
To switch to another color theme, hover the "Home" menu for the main wiki and the "Wiki" menu for a sub-wiki and click on
"Administer Wiki". Next, in the global administration page, click on the "Presentation" link from the vertical menu to the left.

In the "Color Themes" section, select the color theme you wish to use from the drop-down list, then click on "Save"

or click on "Manage color themes".
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On the Color Themes page you will see the list of the available themes. Once you have decided about the one you want, click
on "Use this theme".

Refresh the page and you will be able to see the new theme on your wiki.
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Configure Annotations
Annotations can be configured from the dedicated section in the wiki administration page. To change the default settings, hover
the "Home" menu for the main wiki

or the "Wiki" menu for a sub-wiki and click on "Administer Wiki". 

Next click on the "Annotations" link from the vertical menu to the left.
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From this section you may configure:

• Whether annotations are enabled
• Whether annotations are enabled on the whole wiki or on a subset of spaces
• Whether annotations are displayed by default or only when checking the "Show annotations" option on each page
• Whether the annotations highlight should always be displayed or whether it should only appear when hovering an

annotation
• Extra properties for the annotations.
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Note that annotations are merged with comments by default so, if you go to the "XWiki Class Defining Annotations
Structure" field from the annotations configuration page, you will see that now it is "XWiki.XWikiComments" instead of
"AnnotationCode.AnnotationClass". The "XWiki.XWikiComments" class has also been modified by adding new properties in
order to support annotations.
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Customize the Language and Timezone Settings
• Set Up the Supported Languages
• Define a Document Bundle
• Write Parametrized Translation Keys
• Translation Keys for Class Fields
• Global Timezone Settings

Set Up the Supported Languages
To set up the supported languages, log in as administrator, hover the "Home" menu for the main wiki

or the "Wiki" menu for a sub-wiki and click on "Administer Wiki".

In the wiki administration page, click on the "Localization" link from the menu to the left.

At this point you have 3 possibilities:

• keep the default settings by leaving "Multilingual" to "---" which means that the default language of the wiki will be
English ("en").
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• set "Multilingual" to "No" and enter the default language you wish to have on your wiki. XWiki currently supports 31
languages as explained in the documentation page about "Internationalization".

• set "Multilingual" to "Yes", enter the supported languages separated by comas ("en,fr,de,es"), then define the default
language for the wiki.

Define a Document Bundle
To enable multiple languages, go to the wiki administration page, set "Multilingual" to "Yes" and list the different languages you
wish to use in the "Supported Languages" field as explained in the above section.

To tell XWiki that your page is a document bundle, go to the wiki administration page, click on the "Localization" link in the
vertical menu to the left and enter it in the "Internationalization Document Bundles" input from the "Translations" section. You
may specify several pages, separated by commas.
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When creating "Internationalization Document Bundles", you should avoid naming the pages with names that include spaces.
For example, a document name of Main.My Messages could cause issues, instead, use Main.MyMessages.

Write Parametrized Translation Keys
First you have to create a page that will host your key/value pairs. Next, add all the key/value pairs to that page using the "Wiki"
editor. For example:

greeting=hello
welcome=Welcome
withparams=I can {0} pass {1} {2} params too using the Java MessageFormat syntax

Finally, on the page where you want to use the internationalized message, use:

$msg.get("key")
$msg.get("key", ["param0", "param1", "param2"])

where key is the key for the message to retrieve.

Translation Keys for Class Fields
Supposing you have a class containing two String properties and one Static List property with two values, the first step would be
to create the document bundle that will store your keys. Next, edit it in "Wiki" mode and enter the keys using the syntax

classFullname_propertyName=Translation Message 

for the String fields and the syntax

classFullname_propertyName_propertyValue=Translation Message

for each value of the Static List property.

To exemplify, suppose you have a class named "EmployeesClass" created in the "Employees" space. This class contains two
String properties, "first_name" and "last_name" and one Static List field, "availability", with two possible values: "active" and
"inactive". Your translation keys will have the following syntax:

Employees.EmployeesClass_first_name=First Name
Employees.EmployeesClass_last_name=Last Name
Employees.EmployeesClass_availability=Availability
Employees.EmployeesClass_availability_inactive=Inactive
Employees.EmployeesClass_availability_active=Active

On the page where you want to use the internationalized message, for instance the sheet of the class "EmployeesClass", you
will use:

$msg.get("Employees.EmployeesClass_0_first_name")
$msg.get("Employees.EmployeesClass_0_last_name")
$msg.get("Employees.EmployeesClass_availability")
$msg.get("Employees.EmployeesClass_availability_inactive")
$msg.get("Employees.EmployeesClass_availability_active")
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Global Timezone Settings
XWiki Enterprise comes with the "Localization" section in the wiki administration page allowing administrators to globally set
the timezone without the need to directly access the server. So, in order to use a specific timezone for the whole wiki, just select
it from the "Timezone" drop-down list in the "Date/Time" section. 

    

Related Pages

• User Guide
• User Preferences
• Search Application
• Internationalization

• Admin Guide
• The App Within Minutes Application
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Configure the Wysiwyg Editor
• Configuration Overview
• Access the Wysiwyg Administration Page
• General Settings
• Customize the WYSIWYG Toolbar

• Load a Plugin
• Add a Menu Item
• Add a Toolbar Feature and a Toolbar Separator
• Remove a Plugin
• Remove a Menu Bar Item
• Remove a Toolbar Feature or a Toolbar Separator

• Limit the Attachments Selection
• Image Settings

• Allow the Insertion of External Images
• Limit the Image Selection

• Color Settings
• Set the Number of Colors to Display
• Add a Color to the Palette
• Remove a Color from the Palette

• Font Settings
• Add a Font Name
• Remove a Font Name
• Add Font Sizes
• Remove Font Sizes

• Style Settings
• Create a Style
• Customize the Newly Created Style
• Remove a Style

• Customize WYSIWYG by Overriding the "XWiki.XWikiPreferences" Class
• Plugins and Features
• Examples

• Enable text coloring and formatting features
• Add a macro shortcut icon on the editor tool bar

Configuration Overview
XWiki allows you to configure the menus and toolbar features displayed by the Wysiwyg editor.

The WYSIWYG configuration can be done via the UI available in the wiki administration page or by editing the
'XWiki.XWikiPreferences' class.

Additional layout changes can be achieved by overriding the wiki skin, as shown in the dedicated documentation page.
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Access the Wysiwyg Administration Page
Hover the "Home" menu for the main wiki

or the "Wiki" menu for a sub-wiki and click on "Administer Wiki".

Click on the "WYSIWYG Editor" link in the vertical menu to the left to open the Wysiwyg settings page.
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General Settings
To enable or disable the "WYSIWYG" and "Source" tabs, select or deselect the corresponding radio buttons in the "Source
Editor Enabled" section.

You can disable the automatic cleaning when you paste content into the rich text area of the Wysiwyg editor by selecting
"No" in the "Clean paste content automatically" section.
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Customize the WYSIWYG Toolbar
Every new toolbar feature requires a specific plugin and/or menu item. For instance, if you want to enable the color and text
formatting features follow these 3 steps:

Load a Plugin

For this example, you will need to load the "color" and "font" plugins by entering their names in the "Plugins" text-area. Click
on the green "+" icon or press "Enter" to add the plugin to the list. After starting to type, the suggest feature will guide you
through the list of available plugins.

Add a Menu Item

To add the new menu item you have to enter it in the "Menu" text-area and click on the green "+" icon. In our example, this step
is not necessary since all the available menu items are already added by default.
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Add a Toolbar Feature and a Toolbar Separator

For this example, you will have to enter the following toolbar features in the "Tool Bar" input:

• backcolor and forecolor corresponding to the color plugin
• fontname and fontsize corresponding to the font plugin

To see the toolbar features available for each plugin, follow this link.

You can also add a toolbar separator by entering the "|" character in the "Tool Bar" input.

Click on "Save" and edit any page to see the changes.

Remove a Plugin

Hover the plugin you wish to remove from the list and click on the red "X" icon in the top right corner.
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Remove a Menu Bar Item

Hover the menu bar item you wish to delete from the list and click on the red "X" icon in the top right corner.

Remove a Toolbar Feature or a Toolbar Separator

Hover the toolbar feature you wish to remove from the list and click on the red "X" icon in the top right corner.

The same steps apply if you wish to remove any toolbar separator.

Limit the Attachments Selection
When creating a link to an attachment, you can restrict users to choose only from the files attached to the edited page by
checking the "Yes" radio-button in the "Link Settings" section.
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Image Settings

Allow the Insertion of External Images

You can allow users to insert images that are not attached to a wiki page, by checking the "Yes" radio-button in the "External
Images" section.

Limit the Image Selection

Users can be restricted to choose the image to insert only from those attached to the edited page by checking the "Yes" radio-
button in the "Image Selection Limited" section.

Color Settings

Set the Number of Colors to Display

To choose the number of rows and columns of the color picker, fill in the "Rows" and "Columns" text-boxes in the "Colors Per
Row" section and click on the "Refresh" button. The default value is 8.
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Add a Color to the Palette

To add a new color, click on any transparent square in the palette.

You will then see a color dialog from which to select the desired color.

Close the color dialog to complete.

Remove a Color from the Palette

To remove a color, just click on the corresponding square in the color picker and choose "White" from the color dialog.
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Close the color dialog to complete.

Font Settings

Add a Font Name

To add a font name, fill it in the text-box in the "Font Names" section and click on the green "+" button. The new font name
will appear in the drop-down list.

Remove a Font Name

To remove a font name, select it from the drop-down list in the "Font Names" section and click on the red "X" button in the top
right corner.
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Add Font Sizes

To add a font size, fill it in the text-box in the "Font Sizes" section and click on the green "+" button.

Remove Font Sizes

Hover the font size you wish to remove from the list and click on the red "X" in the top right corner.

Style Settings

Create a Style
In order to have a custom style, you will need to have access to the file-system.

To add a style, fill in the "Style Name" and "Style Label" text-boxes in the "Style Settings" section and click on the "Add"
button. By not checking the "Inline style" option, you will create a block style.
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Customize the Newly Created Style

In order to customize your style, go to the "\webapps\xwiki\skins\" folder located on your file-system and look for the folder
corresponding to your skin (albatros, colibri, toucan or any other custom skin). Supposing you are using the colibri skin,
open the "\webapps\xwiki\skins\colibri\" folder, edit the colibri.css file and add your custom CSS code.

Example:

.MyStyle {
color:red;
}

Next, go to the WYSIWYG administration section , load the 'style' plugin, add the 'stylename' toolbar feature and click on
"Save".

In order to see the changes, restart XWiki then edit any page in "WYSIWYG" mode. You should then see the "Styles" feature
on the toolbar.

Select "MyStyle" from the "Styles" drop-down list and start editing.
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Remove a Style

To remove a style, select it from the drop-down list in the "Style Setting" section and click on the red "X" in the top right
corner.

Customize WYSIWYG by Overriding the "XWiki.XWikiPreferences" Class
XWiki allows you to extend the "XWiki.XWikiPreferences" class with properties dedicated to storing editor configurations and
here are the steps for achieving this:

1. Edit the XWiki.XWikiPreferences page in "Class" mode (E.g.:ServerName/xwiki/bin/edit/XWiki/
XWikiPreferences?editor=class)
Next, add the following properties:

• wysiwyg.plugins as a TextArea property

• wysiwyg.menu as a String property

• wysiwyg.toolbar as a TextArea property

Close the editing by clicking on  "Save & View".

2. Edit the "XWiki.XWikiPreferences" page in "Objects" mode (E.g.:ServerName/xwiki/bin/edit/XWiki/
XWikiPreferences?editor=object), fill in the configuration properties. For the full list of options see the Plugins
and Features section.

Here is an example of a configuration enabling most of the editor features:
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Edit a page to see the changes.

Plugins and Features
Every editor feature requires a plugin (module). Check out the table below to see which features or UI elements are enabled by a
specific plugin.

Note that every feature and menu will need to be listed explicitly in the "XWiki.XWikiPreferences" configuration.
The Plugin Name, Toolbar Features and Menu columns match the plugins, toolbar and menu configuration parameters
respectively.

Plugin Name Description Toolbar Features Menu

color Controls the colors used inside
the rich text area

• forecolor: text color
• backcolor: highlight color

-

font Controls the font used. • fontname: change the
font name

• fontsize: change the font
size

-

format Applies or removes predefined
text styles.

• format: format the text as
heading or paragraph

• removeformat: remove
all in-line text formatting

-

history Controls the editing history. • undo: go one step back in
the editing history

• redo: go one step forward
in the editing history

-

image Adds support for inserting and
editing images.

- image

import Adds support for importing
external content.

• import:officefile: import
office document

• paste: paste rich text from
the clipboard

import

indent Allows you to increase or
decrease the indentation of list
items.

• outdent: decrease
indentation

• indent: increase
indentation

-

justify Controls the text alignment. • justifyleft: align text left
• justifycenter: center text
• justifyright: align text

right
• justifyfull: justify text

-

line Controls the behavior of the
Enter key inside the rich text area.

- -
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link Add support for creating and
editing different kind of links.

- link

list Adds support for creating lists. • unorderedlist: creates
bulleted lists

• orderedlist: numbered
lists

-

macro Adds support for inserting and
editing macros.

• macro:macroId: inserts
the macro with the
specified identifier, e.g.
use macro:velocity to add
a button on the tool bar
that triggers the insert
Velocity macro wizard

macro

separator Offers different kind of content
and toolbar separators.

• hr: inserts a horizontal
ruler

• |: separates toolbar
features in groups

• /: breaks the toolbar in
multiple lines

-

style Enhances the editor with the
ability to apply predefined styles
to the current text selection.

• stylename: installs a list
box on the tool bar with
the available styles

-

submit Ensures that the content of the
editor is submitted and also
cached by the browser.

- -

symbol Allows you to insert a special
symbol.

• symbol -

table Adds support for inserting and
editing tables.

- table

text Offers standard text formatting. • bold: formats text as bold
• italic: formats text as

italic
• underline: formats text as

underlined
• strikethrough: formats

text as stroke through
• teletype: formats text as

monospace

-

valign Allows you to write simple
formulas.

• subscript: formats the
text as subscript

• superscript: formats the
text as superscript

-

Examples

Enable text coloring and formatting features

Edit the page 'XWiki.XWikiPreferences' in Class and Objects mode and fill in the properties as following:

• for the wysiwyg.plugins property:
submit line separator embed text valign list indent history format symbol link image table macro import color font

• for the wysiwyg.menu property:
link image table macro import

• for the wysiwyg.toolbar property:
bold italic underline strikethrough | subscript superscript | unorderedlist orderedlist | outdent indent |
undo redo | format | hr symbol | paste | fontname fontsize forecolor backcolor

Add a macro shortcut icon on the editor tool bar

If you are using a macro very often then you might want to add it to the editor tool bar for quick access. To do so, follow the
steps described here.

Related Pages

• User Guide

http://platform.xwiki.org/xwiki/bin/view/AdminGuide/WysiwygEditor#HAddan27InsertHTMLmacro27buttononthetoolbar
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• WYSIWYG Editor
• The Office Importer Application
• Editing Modes

• Admin Guide
• Pages and Spaces Overview
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Customize the Search Feature
• The Search Administration UI
• Set the Default Search Engine
• The Solr Index

• Solr Search Debug Mode
• Restrict the List of Wikis that are Searchable by Default

• The Lucene Index

The Search Administration UI
To access the Search administration UI, hover the "Home" menu for the main wiki

or the "Wiki" menu for a sub-wiki and click on "Administer Wiki".

In the wiki preferences page, click on the "Search" link in the vertical menu to the left.
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Set the Default Search Engine
The default XWiki search engine is Solr, but you may also pick "Database" or "Lucene".

The Solr Index
Solr is the default XWiki Enterprise search engine based on Apache Solr which has its own index, separate from the Lucene
index. The default folder that stores the Solr index is <permanent folder>/solr but you can change it by adding the
property search.solr.home to the file "WEB-INF/xwiki.properties".

The SOLR search module automatically indexes the changes made on the wiki and at each startup a background job checks
if the Solr index and the database are synchronized. If not, the job only applies the updates. Also, entities are now indexed with
the list of supported locales, which means that if your current locale is "fr_FR" you will find all entities that you would have
seen when the current locale is "fr_FR". 

The manual indexing is still available because it is more stable so, in order to perform it, go to the "Solr search
administration" section, choose the action you wish to perform on your wiki:

http://lucene.apache.org/solr/
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• add documents to the Solr index
• remove documents from the Solr index
• re-index a wiki of your choice or the entire farm

then click on "Apply".

The actual reading of wiki documents and their indexing is done in a safe background thread and in the "Queue Size" section
you can see the number of entities that are left to be indexed, re-indexed or deleted from the index.

In case you wish to limit the documents that will be affected by the selected action, you can use a custom HQL or XWQL
query.
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After clicking on "Apply" to trigger the index, you will see a confirmation message.

Solr Search Debug Mode

You can now debug the Solr search query string by adding &debug=true to the "Main.SolrSearch" URL query string. For
instance, we are looking for the word "activity" in all the wiki documents. The search URL will then be like
/xwiki/bin/view/Main/SolrSearch?f_type=DOCUMENT&text=activity&f_locale=en&f_locale=&r=1&debug=true
and will display:

• the used query parser: ExtendedDismaxQParser
• the parsed query in order to see which index fields are used and what is their priority:

+((objcontent_en:activ | objcontent__:activity)^0.4 | creator_display:activity^0.08 |
(title_en:activ | title__:activity)^10.0 | (doccontent_en:activ |doccontent__:activity)^2.0 |
attauthor_display:activity^0.016 | author_display:activity^0.08 | name:activity^10.0 |
filename:activity^0.4 | (attcontent_en:activ | attcontent__:activity)^0.4 |
space:activity^0.016 | (comment__:activity | comment_en:activ)^0.016 |
(doccontentraw__:activity | doccontentraw_en:activ)^0.4)

• the filter queries in order to know the facets that were applied and their values: {!tag=type}type:("DOCUMENT")
{!tag=locale}locale:("en" OR "")

• the processing time
• the score for each search result and the way it was computed
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Restrict the List of Wikis that are Searchable by Default

You can now restrict the list of wikis that are searchable by default from the main wiki by defining the following Velocity
variable in a page that includes "Main.SolrSearch":

#set ($wikisSearchableFromMainWiki = ["wiki1", "wiki2", "wiki3"])

The Lucene Index
The Lucene search administration page displays the number of indexed elements and the number of elements in the indexing
queue.

You may index the whole farm or only a sub-wiki of your choice or you can:

• Define an HQL based filter query (only available if you have programming rights)
• Clear the index and start to re-index
• Choose to only index the elements that are not already indexed
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Note that momentarily the indexing is done only manually so, in order to get any search results, you have to first index or re-
index the wiki. This means that the changes in the content of the wiki will not be searchable until you manually re-index. 

The default folder that stores the Lucene index is <permanent directory>/lucene but you can change it by editing
the parameter xwiki.plugins.lucene.indexdir from the file "WEB-INF/xwiki.cfg".

     

Related Pages

• User Guide
• Search Application

• Programming Guide
• XWiki Query Guide
• Solr Schema and API
• Lucene Plugin

• Admin Guide
• Search Suggest Sources
• Pages and Spaces Overview
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Search Suggest Sources
• Disable Search Suggest
• Choose the Search Engine to Use
• Edit a Search Suggest Source
• Add a Search Suggest Source
• Delete a Search Suggest Source

Disable Search Suggest
To disable the search suggest, hover the "Home" menu for the main wiki

or the "Wiki" menu for a sub-wiki and click on "Administer wiki". 

In the wiki administration page, click on the "Search Suggest" link from the vertical menu to the left.
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Choose "No" in the drop-down list then click on "Save".

Choose the Search Engine to Use
The search suggest is now using the Solr engine by default, due to the fact that we have created a search suggest service based
on Solr. We have also added search suggest sources that mimic the behavior of the existing Lucene-based ones so that now the
search suggest takes into account the configured search engine. You can easily switch between the Solr-based 
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and the Lucene-based search suggest by clicking on the corresponding tab of the table in the "Sources" section, then on the
"Save" button.
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By default, the search is done in:

• the name of the document
• the content of the document
• the name of the attachment
• the content of the attachment
• user name
• blog post
• wiki

Edit a Search Suggest Source
To modify a search suggest source just click on it and an edit form will open. If you choose to edit for instance "Document
names", you should see the image below:
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The form displays the suggest source information such as:

• the name represented by a translation key
• the search engine to use when retrieving results
• the search suggest service
• the query passed to the search suggest service
• the maximum number of search results taken from the current source with "3" as default value
• the icon used to mark the search results
• whether the searched text will be highlighted in the search suggest results
• whether the current suggest source is used or not; note that this option is taken into account provided the source search

engine matches the search engine used by the current wiki

You can now specify more advanced search parameters in the search query and they will be passed directly to the search
engine. For instance, the old (title:__INPUT__* OR name:__INPUT__*) AND type:DOCUMENT query can now be written
as:

fq=type:DOCUMENT
qf=title^2 name

The main advantages are:

• the query filter is the same for all search request made to the current Search Suggest source because it is cached by Solr
• the ability to specify the boost for each field 
• if not specified, the __INPUT__ is still used by default 

Backwards compatibility with existing Solr Search Suggest sources is still preserved. More information about the commons
query parameters are available in the "Solr Schema and API" documentation page which is listed in the "Related Pages" section.
After you have made your changes, don't forget to click on the "Save" button. If on the contrary you don't need to edit the
suggest source anymore, click on its name to collapse the form. 

Add a Search Suggest Source
To add a search suggest source, click on the "Add a new source" link which will open the creation form. Supposing that you
want to search in the document title but without displaying the results from the spaces "Admin", "XWiki" or from any space
beginning with "Doc" and "Lib", the form would look like in the image below:
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Click on "Save" after you are done, refresh the page and the new source will be displayed in the "Solr" tab.

If you then search for any term, you will see the new "Document Title" section in the suggestion box.
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Delete a Search Suggest Source
To delete a search suggest source, just hover it, click in the red "X" icon
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and confirm.

     

Related Pages

• User Guide
• Search Application

• Programming Guide
• Solr Schema and API
• Lucene Plugin

• Admin Guide
• Pages and Spaces Overview
• Customize the Search Feature
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Customize the User Profile Sections
• Choose Which Sections to Display

• Customize the "Personal Information" Section
• Customize the "Contact Information" Section
• Customize the "External Links" Section
• Modify the Section ID

• Add a Section
• Remove a Section
• Extend the Class "XWiki.XWikiUsers"

An administrator can choose which information is shown in the user profile tab. For this purpose, the "User Profile" section
has been added to the vertical menu in the wiki preferences page so that now an administrator can decide which fields of the
XWiki.XWikiUsers class to display. 

Choose Which Sections to Display
In the text-box below "Section IDs" you can enter a space or newline separated list of section IDs to be displayed in the user
profile. The IDs available by default are:

• personal : the "First Name", "Last Name", "Company" and "Comment" subsections
• contact : the "Email", "Phone" and "Address" subsections
• links : the "Blog" and "Blog Feed" subsections
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Customize the "Personal Information" Section

You may choose which personal information to display by entering a space or newline separated list of XWiki.XWikiUsers
properties in the text-box below "Section Properties". The values listed by default are:

• first_name
• last_name
• company
• comment

You may also use an optional microformats class to prefix the property name (e.g.: given-name:first_name).

Customize the "Contact Information" Section

Just like for the above section, you can choose which information to display by entering a space or newline separated list of
XWiki.XWikiUsers properties in the corresponding text-box. There are 3 default options available: 

• email
• phone
• address

You may also use microformats class to prefix the property name (e.g.: tel:phone).
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Customize the "External Links" Section

The values listed by default in this section are:

• blog
• blogfeed
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The XWiki.XWikiUsers class properties can be prefixed using a microformats class.

Modify the Section ID

You may change the section ID by entering it in the corresponding text-box. Note that the name you specify in the "Section ID"
field (without containing any white spaces) must be the same as the one from the "Section IDs" text-box. 
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Add a Section
In the User Profile administration page, go to "All sections" and click on the "Add" link. 

Next, go to the bottom of the page and you will notice 3 new corresponding "Section ID", "Section Name" and "Section
Properties" fields. 
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Fill in the 3 fields and click on "Save" to apply changes. Note that the section properties must exist in the
XWiki.XWikiUsers class which is available at ServerName/xwiki/bin/edit/XWiki/XWikiUsers?editor=class.

In order for the new section to appear in the user profile, you also need to specify its ID in the "Section IDs" text-box.
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To edit the subsections, just click on the yellow pen icon located at the top of the user profile page.

Remove a Section
Go to the User Profile administration page and click on the corresponding "Remove" link located to the right of the section. 
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Extend the Class "XWiki.XWikiUsers"
When customizing the user profile sections, you are not limited to the properties that already exist in the "XWiki.XWikiUsers"
class. It it possible for you to extend the class then to display the new sections in the user profile. To do so, navigate to the page
"XWiki.XWikiUsers" and edit it in "Class" mode.

Supposing you need to add a section named "Job Information" which will display the manager and the contract type of each
employee, you will need:

• a property of type "List of Users" in order to select the name of the manager from the existing wiki users

In case the employee is a member of several teams and he/she has more than one manager, just check the "Multiple select"
option. More information regarding the User Picker is available in the documentation about how to edit a group.

• a "Static List" property with the following possible values: "Full-time" and "Part-time"
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After saving the class page, go to the User Profile administration and create a new section named "Job Information" with the
"job_information" ID as explained in the above section. Finally, add the new "manager" and "contract" section properties,
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specify the "job_information" ID in "Section IDs"

and click on "Save". The new section will then appear in the user profile. 
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Related Pages

• User Guide
• XWiki Dashboard Application
• User Profile

• Programming Guide
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• XWiki Data Model
• Admin Guide

• The App Within Minutes Application
• Edit a Global User
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Disable the Message Stream
To disable the message stream, hover the "Home" menu for the main wiki

or the "Wiki" menu for a sub-wiki and click on "Administer Wiki".

In the wiki preferences page, click on "Message Stream" from the vertical menu to the left.
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In the "Message Stream" administration page, select "No" from the drop-down list, then click on "Save".

If you then navigate to the wiki home page where the {{messageSender /}} macro is displayed by default or to your user
profile page you will see that it is not shown anymore.

 

Related Pages

• User Guide
• XWiki Dashboard Application
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• User Status
• Activity Stream

• Admin Guide
• Users and Groups Overview
• Activity and Watch Overview
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Extension Manager Application
• Description
• Access the Extension Manager

• Install an Extension from the Main Wiki
• The Advanced Search
• Browse the Installed Extensions from the Main Wiki
• Upgrade an Extension
• Merge Conflict Resolution
• Downgrade an Extension
• Uninstall an Extension
• Search for XWiki Core Extensions
• The Extension Updater

This Extension Manager is a feature for installing, uninstalling, upgrading and downgrading XWiki extensions.

Description
The Extension Manager allows you to:

• download extensions from a remote repository to a local repository
• install, upgrade, downgrade and uninstall any type of extension as long as you have a handler
• browse the list of installed extensions
• compare the extension versions
• see a short description of each extension
• see the list of dependencies for an extension
• see if the extension you are about to install is compatible or not with the current XWiki Enterprise instance

You can install an extension on the whole farm or only the main wiki.

At the moment, the Extension Manager supports the following repositories:

• the xwiki.org Extensions Repository which is currently searchable
• the XWiki Public Nexus Maven Repository

In order to be able to install extensions from the XWiki Public Nexus Maven Repository, you can use the Advanced Search.
If you want to add more repositories, please follow this link.

Access the Extension Manager
For an administrator user there are 2 ways of accessing the Extension Manager. The first one is by clicking on "More
applications" then on "Install new applications" in the "Applications" panel on the right. 

The second possibility is by clicking on "Administer Wiki" in the "Home" menu for the main wiki or in the "Wiki" menu for
a sub-wiki.

http://extensions.xwiki.org/xwiki/bin/view/Main/WebHome
http://nexus.xwiki.org/nexus/content/groups/public/
http://nexus.xwiki.org/nexus/content/groups/public/
http://extensions.xwiki.org/xwiki/bin/view/Extension/Extension+Module
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In the vertical menu to the left, click on "Extension Manager"

to see the list of possible actions:

• add extension
• see the list of installed extensions
• see the list of extensions that make the XWiki core
• check for updates for the installed extensions
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If you wish to install an extension on a specific sub-wiki you need to access the Extension Manager of that sub-wiki. The
steps are the same as for the main wiki.

Install an Extension from the Main Wiki

To install an extension, go to the Extension Manager home page from the main wiki and click on "Add Extensions". You may
browse through the list of available extensions by typing the extension name / a keyword. There are 3 extension categories:

• local extensions which are cached locally and remain cached even after uninstalling them
• installed extensions which are included by the local extensions
• core extensions

Hit "Enter" to display the results.
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More information about each extension is available in the "Description" tab by clicking on "Show Details". You will
notice some extra information like the group ID, the artifact ID or the list of stable releases that can be downloaded from the
configured extension repositories.
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The "Dependencies" tab lists extensions or packages you have to install in order for the current one to function correctly.
For the already provided dependencies, the extension status bar is green. The time needed to display the extension details has
considerably decreased due to the fact that the Extension Manager tries to resolve all the extension dependencies by making
requests to the configured remote repositories.
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If the extension version is incompatible with your wiki instance, you will see a red status message. To find a compatible
version, you can use the Advanced Search.
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Supposing you want to install the version 5.4 of the "FAQ Application", click on "Install" and you will be prompted about the
new extension. The "Install" and "Install on Farm" buttons from the drop-down menu and allow you recompute the install plan.

A very important detail you should take into account is that by clicking on "Install" the extension will only be installed on the
main wiki. 

Should you decide to install it on the sub-wikis too, just click on "Install on Farm".
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In both cases, click on "Continue" to confirm and start installing the extension. Since the process is asynchronous, you will
soon see a progress bar. Also, the install plan is progressively displayed in order for the user to receive constant feed-back.

Once the progress bar has reached 100%, if you search for the "FAQ Application" in the installed extensions, then click on
the "Description" tab, you will see a message saying the extension is installed globally.
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In case the extension job fails, the error message is extracted and displayed so that the user can click on it and access the stack
trace.

The Advanced Search

You may search for the extension ID and version by clicking on the "Advanced search" link. The ID of a Maven extension has
the following syntax: groupId:artifactId.
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Click on "Search" to display the results.

If you are not sure about the group ID and the artifact ID, go back to the "Add Extension" section and search for the
extension you want to install. Next, click the "Show Details" button and you will find the necessary information in the
"Description" tab. Also, the released versions of the extension are available by clicking on the "Stable versions" link.



XWiki Enterprise 5.4.4 Admin Guide

Page 207

Browse the Installed Extensions from the Main Wiki

To see the installed extensions, go to the Extension Manager home page and click on "Installed Extensions". You will then see
the FAQ Application listed in the results page with a green extension status.

If you chose to install the extension on the whole farm, you will see an "Upgrade on Farm" or an "Uninstall from Farm"
button and the "Installed globally" message in the "Description" tab as in the image below.
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If the extension has only been installed on the main wiki, you will only see an "Upgrade" or an "Uninstall" button and an
"Installed on the following namespaces - Home" in the "Description" tab.

Upgrade an Extension

You can only use Extension Manager to upgrade the extensions installed by the user, i.e. not the core extensions. To do so, go to
the Extension Manager home page and click on "Add Extensions". Supposing you have previously installed version 5.4 of the
FAQ Application, if you search for it again, you will notice an "Upgrade" button. In case you have installed the application on
the sub-wikis too, you will see an "Upgrade on Farm" button.
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The search results always display the most recent version of the extension which might not be compatible with the current
XWiki runtime. To look for a compatible version, you can use the Advanced Search.

Click the "Upgrade on Farm" button then on "Continue" and you will be notified about the version to which your extension
will be upgraded (5.4.2 in our case).

If you then go to the installed extensions and search for the "FAQ Application", you will see that the new version is now
5.4.2.

Merge Conflict Resolution

Supposing you have installed a XAR extension on which you have made some changes and you wish to upgrade it. If the
Extension Manager fails to automatically merge your changes with the ones from the newer version, it will guide you through
the process of resolving the conflict. 

So, if for instance you have modified the version 1.1 of the JIRA macro and you wish to upgrade to version 1.2, you will see
a diff between the current version and the merged version of the macro in the "Description" tab after clicking on "Upgrade" or
on "Upgrade of Farm". The diff includes metadata, content and object changes.
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You can also display a diff between the current version and the newer one or any other combination by clicking on "Show
Changes". 

If you choose to keep the merged version of the document (which will override some of your changes) click on "Continue".
The other 2 options available in the "Merge Conflict" drop-down list are:

• Keep only the new version of the document which will override all your previous changes
• Keep the current version of the document with the mention that the extension might now work properly

Downgrade an Extension

The Extension Manager comes with a new "Downgrade" feature which, at the moment, is only available using the Advanced
Search.

Supposing you have installed the version 5.2 of the FAQ Application and you want to install version 5.1, go to the list of
installed extensions and click on "Advanced search". Fill in the 2 text-boxes like in the image below,

then click on "Search". You will be then notified that the version 5.2 of the application is already installed. 

Click on "Downgrade" or on "Downgrade on Farm" in case you have installed the application on the sub-wikis too,
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then on "Continue" to confirm.

Uninstall an Extension

To uninstall an extension, go to the list of installed extensions then click on the corresponding "Uninstall" button or on the
"Uninstall from Farm" button in case you have installed the extension on the sub-wikis too. In the "Progress" tab, you will
be prompted about the list of packages you are about to remove. The uninstall plan is progressively displayed so that the user
receives constant feed-back.

Click on "Continue" to confirm.
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If you want to uninstall the extension only from a specific sub-wiki, follow the same steps, but using the Extension Manager
of that sub-wiki.

Search for XWiki Core Extensions

The Core extensions are bundled with XWiki Enterprise and they are available by navigating to the Extension Manager home
page and by clicking on "Core extensions". You won't be able to uninstall, downgrade or upgrade any of the core extensions
using the Extension Manager. To upgrade a core extension, you will need to upgrade the XWiki Enterprise WAR.

The Extension Updater

The "Extension Updater" section lists available updates for the installed extensions.
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To upgrade an extension, click on the corresponding "Upgrade" or "Upgrade on Farm" button and follow the on-screen
instructions. In case the displayed information is outdated, just click on the "recompute" link.

     

Related Pages

• User Guide
• XWiki Applications
• XWiki Applications

• Programming Guide
• Skins Extensions

• Admin Guide
• The Wiki Manager Application
• The App Within Minutes Application
• Distribution Wizard
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The App Within Minutes Application
• View Your XWiki Applications
• Create an XWiki Application

• Set the Name
• Define the Structure of the Application
• Customize the Home Page
• Edit the Application

• Translate Your Application
• Edit the Application Class
• Edit the Application Home Page
• Add Entries
• Edit an Entry

• Delete an Application

XWiki Enterprise comes with the "App Within Minutes" wizard to help you create collaborative applications within minutes
which are based on the XWiki Enterprise structured data management system. 

To prepare this feature, XWiki Enterprise has introduced a new way of associating the created objects with the sheets used
to display them. Previously, the document had to explicitly contain an {{include}} macro in order to display the attached
object, whereas now the object can pull the sheet automatically. For more details, go to the "Sheet Binding" and "Document
Binding" sections in the documentation about the "XWiki Data Model".

The "App Within Minutes" feature also uses the Livetable application which allows you to display XWiki documents in a
livetable based on an XWiki class selectable from a drop-down list. 

View Your XWiki Applications
To visualize your web applications, click on "More applications" then on "Create your own" link in the "Applications" panel to
the right

or type the following URL in your browser: ServerName/xwiki/bin/view/AppWithinMinutes/WebHome. You should then see
the main page containing a livetable with all your web applications.
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Create an XWiki Application
To create an application, go to the 'AppWithinMinutes' home page and click on "Create Application" which will open a wizard
to guide you through the process.

Set the Name

The first step consists of establishing the name of the application which is used to determine the URL of the home page, of the
space in which the application will be stored and also of the class containing the structure of the application.

Click on the "Next Step" button once you are done.

Define the Structure of the Application

The second step is about defining the class containing the application structure. The available fields are mapped directly to
XClass property types:

• String
• Long Text
• Number
• Boolean
• Static List
• Date
• User of type "List of Users"
• Group of type "List of Groups"
• Database List
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or mapped to a document field:

• Content for which the value will be stored in the content of the application entry i.e. the content editable in "Wiki" or
"Wysiwyg" mode

• Title for which the value will be stored in the title of an application entry

Note that you will only be allowed to use one "Content" or "Title" field per application.

Supposing you want to create an application which lists all your present and former employees, you will need 8 properties in
the class:

• a "Title" field for the title of the application entry
• a "Short Text" field for the first name
• a "Short Text" field for the last name
• a "Short Text" field for the email address
• a "Static List" field for the availability of each employee: active or inactive
• a Date Picker for the ending date of the contract
• an "User" field for the manager
• a "Content" field for any additional comments

To do so, you just have to drag and drop the fields from the palette to the right. For the first name, last name and email
address we will choose the "Short Text" field.

"Short Text" is the default "pretty name" of the property. In order to change it to "First Name", click on the text and start
editing. You will notice that the background color will change.

To configure the property, hover it and click on the key icon in the top right corner.
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In the input just below "First Name" you can enter the default value to use when creating employee entries. The "Name" text-
box refers to the name of the class property. 

When you are done, click on the green "Accept" icon in the top right corner to apply the changes.

In case you have changed your mind about using this field, you can delete it by clicking on the red "X" in the top right corner.

For the other 2 fields, "Last Name" and "Email", just repeat this process.

For the "Title" property you must know that visually there is no difference between this field and a "Short Text" field. 

In order to define the availability of each employee, we will use a "Static List" field. By default, there are 3 options available.
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To configure the list, click on the "key" icon in the top right corner. If you want to add an option, enter the "Value" and the
"ID" then click on the green "+" icon.

To remove an option, hover it and click on the "X" in the top right corner.
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Add the "Inactive" option and save the changes.

For the ending date of the contract, drag-and-drop the "Date" picker field from the palette. You may change the date format
and specify the current date as default value by selecting the "Empty Is Today" check-box.
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For the "Manager" column we will use the "User" field. XWiki Enterprise comes with a User Picker which is used by default
by all the XCLASS properties of type "List of Users". 

The picker displays the user avatar and a link to the user profile and it allows you to select one or multiple default values,
provided the "Multiple Select" option is checked.

If the "Multiple Select" option is checked, each selected user will be added to the list above the picker.
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In case you want to delete the default value in singleton mode, you may either select another user or hover the current user
name and click on the red "X" in the top right corner.

In multiple select mode, you may remove all the users from the list by clicking on the "Clear selection" link.

Visually, the "Content" field is equivalent to a "TextArea" property and it will load the default editor you have set in your user
preferences page.
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Click on the "Next Step" button when you are done.

Customize the Home Page

The last step allows you to customize the web page of your application, by adding a description and by managing the columns of
the livetable in which the entries will be displayed.
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To add a column, select it from the drop-down list then click on the green "+" button. Your may choose between the generic
livetable columns or you may add the ones corresponding to the fields created earlier.

To remove a column, hover it and click on the "X" in the top right corner. It is also possible to move the columns with a
simple "drag and drop".

You may associate an icon with your application by providing a reference to an 16x16 icon. The syntax is
icon:the_name_of_the_icon and the default images are available by clicking on the "default icon set" link in the
"Icon" section. The URL points to the "\webapps\xwiki\resources\icons\silk" folder on your filesystem.

The icon will then appear in the "Applications" panel.
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Click on "Finish" to see the home page of your web application.

At this point, you have 2 options: edit the application class or add entries.

Edit the Application

Translate Your Application

The App Within Minutes wizard generates a document translation bundle which allows you to translate the pretty names of class
properties and livetable columns. In this case there are 2 scenarios. If you already have an application which was created with
App Within Minutes, you will just have to edit it and save it in order to generate the new translation bundle. In case your wiki is
set for multilingual support  go to the application home page and click on "Translate Application" in the "Actions" menu.
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The link will redirect you to the document translation bundle. If you don't need to modify any translation keys, just scroll
down and save the page. 

Edit the Application Class

In the application home page, click on the "Edit Application" link located in the "Actions" panel.

You will then get back to the second step of the wizard. In order for the changes to be reflected on the class sheet and the
class template, the options "Update Class Sheet" and "Update Class Template" are selected by default. 



XWiki Enterprise 5.4.4 Admin Guide

Page 227

The App Within Minutes wizard now comes with an extra option in case you want to update the translation bundle. However,
for the default language of the application the translation is regenerated each time so you may lose your custom translation keys.
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Edit the Application Home Page

Click on "Next Step" and you will be redirected to the third step of the wizard where you may modify the description, change
the icon as well as the way the columns are displayed. Click on "Finish" when you are done and you will get back to the
application main page.

Add Entries

In the application home page, click on the "Add New Entry" link located in the "Actions" panel. A popup will appear, requiring
to specify the name of the entry.

By clicking on the green "+" button, you will create the "Martin Daniels" wiki page. The page will open in "Inline" mode and
will contain all the class fields you have added earlier. To enter a date, just click inside the "Ending Date" text-box which will
open the calendar picker.

After filling in all the fields, click on "Save & View".
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You will then see the wiki page containing the new entry.
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The new entry is also listed in the livetable from the application home page.

Edit an Entry

To edit an entry, go to the application home page and click on the corresponding "Edit" button in the "Actions" column of the
livetable (see in the above image).
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Delete an Application

To delete an application, go to the home page then click on "Delete Application" in the "Actions" panel.

You will then see an information message announcing you that all documents in the space "Employees" will be moved to
"Recycle Bin". Click on "Yes" to confirm.

Next, another information message will appear announcing you that the pages in the space "Employees" can be found in the
"Recycle Bin".

Click on the link to view the list of deleted documents.
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To restore the application, you will have to restore each of its pages. To do that, just click on the green icon located in the last
column for each document. In order to correctly restore the values for each field of the class entries, the restore order should be
as follows:

• the application home page (the "WebHome" document)
• the application space preferences (the "WebPreferences" document)
• the application class
• the application sheet
• the application template
• the translation bundle
• the livetable results page 
• each of the application entries

      

Related Pages

• User Guide
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XWiki Enterprise Setup Overview
If you are a first time XWiki Enterprise user we recommend that you use the installer to get up to speed quickly. Once you get
more familiar with XWiki you might want to set it up on your own database or in your own container, in which case you will
need to download the WAR file and set it up and use the XAR file to load a default set of pages.

The standalone package provided by the installer includes a Jetty container and an HSQLDB database all set up. However, it
is not supposed to be used in production, since the embedded database does not support large wikis efficiently.

FAQ

XWiki Enterprise Setup and Upgrade

Where do I find the quick installs in order to get more familiar with XWiki Enterprise?
Where do I find the XWiki Enterprise production installs?
What servlet containers can XWiki Enterprise use?
What relational databases can XWiki Enterprise use?
What is Distribution Wizard and how can I use it to upgrade my wiki?
What should I backup before an upgrade?
How do I upgrade the XWiki Enterprise WAR?
Can I use the Distribution Wizard to upgrade an old XWiki Enterprise XAR?
How do I configure the MySQL?
Where do I find the older versions of XWiki Enterprise?

Wiki Management

How do I create a sub-wiki?
How do I access the wiki directory?
How do I edit the wiki parameters?
How do I create a wiki template?
How do I delete a sub-wiki?
How do I configure an access policy for my wiki?

Distribution Wizard
• Step 1 - Upgrade the User Interface
• Step 2 - Upgrade the Wikis
• Step 3 - Upgrade the Extensions
• Report Step
• Upgrade from an Old XWiki Enterprise Version

XWiki Enterprise comes with the "Distribution Wizard" feature, which is triggered when you first access a wiki page in view
mode after an upgrade or a new XWiki Enterprise installation.

In order for the Distribution Wizard to be triggered, you have to log in as administrator.

The install/upgrade guide has 4 steps::

• the "User Interface" step allows installing the default set of wiki pages recommended for the current version of the XWiki
runtime.

• the "Wikis" step allows installing the default set of wiki pages on each sub-wiki.
• the "Extensions" step handles the update of the already installed extensions.
• the "Report" step displays all the changes made to the wiki(s) so that you can perform rollbacks or delete some installed

pages.

The old "Upgrade Mode" was removed from the UI, because both "All-in-one" and "Wiki" modes are now enabled by
default. This means that you can either trigger Distribution Wizard from the main wiki and upgrade all the farm or you can
trigger it separately from each sub-wiki.
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Step 1 - Upgrade the User Interface

In case you haven't finished configuring the wiki, click on "Later" and you will be redirected to the wiki page you have
accessed in the first place. The Distribution Wizard won't be triggered again unless the server is restarted.

Clicking on "Never" means you will be redirected to the wiki page you have accessed in the first place and the Distribution
Wizard won't be triggered again unless you change your distribution. This is usually recommended when you plan to do a
manual install. 

Click on "Continue" in order to get to the first step of the process. You will then see:

• The XWiki distribution that currently runs on your machine - the "XWiki Enterprise - Web" package which is marked
as "Provided". More information about the current distribution is available by clicking on "Show Details". The "Stable
Versions" link in the "Description" tab will list all the previously released versions with links to the repository where each
one is stored.
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• The recommended set of XWiki pages for the current version of the XWiki runtime - the "XWiki Enterprise - UI - Main
wiki" package.

Should you decide to import the recommended set of wiki pages on the main wiki, click the "Upgrade" button and the Install
Plan Log will prompt you about the new extensions.



XWiki Enterprise 5.4.4 Admin Guide

Page 237



XWiki Enterprise 5.4.4 Admin Guide

Page 238

In the "Progress" tab, the extensions incompatible with your current distribution are marked by a red bar because they
require an immediate upgrade. The ones marked by a yellow bar are the extensions that still work correctly with your current
distribution but for which there are newer versions available.

Click on "Continue" to confirm and the Distribution Wizard will start computing the upgrade plan and installing the
extensions. The "Install Log" displays a detailed list of installed or upgraded pages. 
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Once the upgrade process starts there might be some merge conflicts reported, even when the database is empty. To learn
more about how to handle them, follow this link.
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The Distribution Wizard has an additional option, "Resolve automatically", which allows you to resolve all the remaining
merge conflicts automatically by choosing the same option as the one you select in the "Merge Conflict" drop-down list.

Finally, you can delete all the old or unused XWiki pages by selecting the "xwiki" case and clicking on "Continue". By
default, the wiki pages that have been modified are left unselected so that you won't lose your changes.

When the progress bar has reached 100%, go to the "Dependencies" tab to see the list of installed extensions which are
marked by a green status bar then click on "Continue".
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Step 2 - Upgrade the Wikis
For each sub-wiki that the Distribution Wizard detects, you will see the recommended set of wiki pages and an "Install" button.

Click on "Install" so that the Distribution Wizard starts computing the upgrade plan. Just like for the main wiki, previous
extensions that are incompatible with your current distribution are marked by a red bar because they require an immediate
upgrade. 
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Click on "Continue" to confirm and start the upgrade process. Once the progress bar has reached 100%, go to the
"Dependencies" tab and you will see 2 installed extensions marked by a green status bar:

• XWiki Enterprise - UI - Common
• Wiki Application for subwikis

The process is similar for the remaining sub-wikis.
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Step 3 - Upgrade the Extensions
Once you get to the third step of the process, you will have to wait a few minutes for the Distribution Wizard to compute the
upgrade plan which means:

• checking the already installed extensions
• checking the compatibility

The installed extensions are grouped in two categories:

• the "Invalid Extensions" are incompatible with your current distribution and they have compatible new versions; these
ones require an upgrade or a downgrade and are marked by a red status bar

• the "Outdated Extensions" still work correctly with your current distribution but there are newer versions available; these
ones are marked by a yellow status bar

Since we list the extensions by the namespace (wiki) they have been installed on, you will have to review and upgrade each
extension individually by clicking the "Upgrade" button and following the on-screen instructions.

Report Step
XWiki has introduced a new last step in which the Distribution Wizard displays all the changes made to the wiki(s) so that you
can perform rollbacks.
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For each sub-wiki, the new pages are marked by the  icon and the upgraded ones are marked by the  icon.

The available user options are:

•
delete a new page by clicking the  icon

•
delete an upgraded page by clicking the  icon or undo the changes by clicking the  icon

Upgrade from an Old XWiki Enterprise Version
When upgrading from an old version that didn't have the Distribution Wizard, the wizard won't know the version of the
previously installed XAR. This information is used by the Extension Manager in order to automatically merge the wiki pages
from your database with those from the new version of the user interface.

In the first step of the process, the Distribution Wizard will ask you whether you are performing an upgrade or a new install.
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Next, you need to select the version of the previously installed user interface from the drop-down list.

The Distribution Wizard will automatically determine the ID of the previously imported XAR based on the selected version.

In case you had a different user interface previously installed, click on the yellow pen icon and enter the right ID.
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Click the "Yes, this is it" button to get to the next step in which the specified user interface extension will be repaired, i.e.
marked as installed.

Click on "Repair / Install" for the Distribution Wizard to start resolving the extension dependencies. When the progress bar
has reached 100%, go to the "Dependencies" tab to see the list of extensions the default set of pages depend on, then click on
"Upgrade". 

After the repairing process is complete, you will be prompted to install the new version of the user interface. 
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Click the "Continue" button, then follow the steps described in the above section.
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XWiki Enterprise Installation and Upgrade
• Quick Installs

• The Graphical Windows Native Installer
• The XWiki Enterprise Generic Installer
• Download and Install Java
• The XWiki Enterprise Standalone Distribution

• Change the Jetty Port
• Production Installs

• Deploy the XWiki Enterprise WAR
• Install and Configure a Servlet Container
• Install and Configure a Relational Database
• Manually Import the Default XWiki XAR
• Configure the Main Wiki Descriptor

• Running Multiple Instances of XWiki in the Same Container
• Upgrade the Main Wiki

• Backup the Existing Data
• Upgrade the Web Application
• Restore the Database
• Upgrade the XWiki Enterprise XAR

• Upgrade the Sub-wikis
• Backup the Existing Data
• Upgrade the XAR

• Download Older Versions of Our Products

Starting with version 5.2, the support for XWiki Enterprise Manager has stopped and XWiki Enterprise now comes with the
ability to create sub-wikis.

Quick Installs

The Graphical Windows Native Installer

The graphical Windows native installer includes an already configured Jetty container and an HSQLDB database but it requires
administration rights on the target operating system. To install it, you need to execute the latest xwiki-enterprise-
installer-windows-<version>.exe file available here and follow the on-screen instructions.

To start XWiki, click on the "Start XWiki Enterprise" desktop icon which will open a DOS window for the running server.
Next, you have to point your server tohttp://localhost:8080. To stop XWiki, click on the "Stop XWiki Enterprise"
desktop icon.

The XWiki Enterprise Generic Installer

This installer works on all platforms and it needs Java to execute. Just like for the graphical Windows native installer, you
must have administration rights on the target operating system. To install it, you need to double click on the latest xwiki-
enterprise-installer-generic-<version>-standard.jar file available here and follow the instructions.

To learn how to start or stop the server, follow this link.

Download and Install Java
• You need to get Java 1.6 or more from the Java website.
• After installing Java execute the following command

# java -version

and provided your JVM was successfully installed, you should see something similar to:

java version "1.6.0_24"
Java(TM) SE Runtime Environment (build 1.6.0_24-b07)
Java HotSpot(TM) 64-Bit Server VM (build 19.1-b02, mixed mode)

The XWiki Enterprise Standalone Distribution

The standalone installation includes an already configured Jetty container and an HSQLDB database. To install it, you just need
to unpack the file xwiki-enterprise-jetty-hsqldb-<version>.zip available here.

In the directory containing the unpacked zip file, you will also find:

http://enterprise.xwiki.org/xwiki/bin/view/Main/Download
http://enterprise.xwiki.org/xwiki/bin/view/Main/Download
http://www.java.com
http://enterprise.xwiki.org/xwiki/bin/view/Main/Download
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• start_xwiki.sh (start_xwiki.bat for Windows systems) which starts the Jetty server containing the XWiki
platform

• stop_xwiki.sh (stop_xwiki.bat for Windows systems) which stops the Jetty server containing the XWiki
platform

• the webapps/xwiki directory containing the XEM Web Application. You will mostly access:
• the file webapps/xwiki/WEB-INF/hibernate.cfg.xml containing the database communication

hibernate parameters
• the files webapps/xwiki/WEB-INF/xwiki.cfg and webapps/xwiki/WEB-INF/
xwiki.properties containing the XWiki configuration parameters

Next, you have to point your server tohttp://localhost:8080.

Change the Jetty Port

If you already have a Web server running on port 8080, you need to set another port in the start script. This can be done by
editing the file start_xwiki.sh (or start_xwiki.bat for Windows systems) and by modifying the value of the
"JETTY_PORT" parameter. 

You can do the same thing directly in the command line by executing 

./start_xwiki.sh ##port_number##

Production Installs

Deploy the XWiki Enterprise WAR

To install the XWiki Enterprise WAR, you need to get the latest xwiki-enterprise-web-<version>.war  file
available here. This WAR distribution requires the configuration of a servlet container and a relational database to work with it.

Install and Configure a Servlet Container

XWiki Enterprise is able to work with any servlet container. You can consult the installation and configuration instructions are
available for:

• Tomcat
• Jetty
• GlassFish
• WebSphere
• JBoss
• Oracle OC4J
• Apache Geronimo

Install and Configure a Relational Database

XWiki can work with:

• MySQL
• HSQL
• PostgreSQL
• Oracle
• DB2
• Microsoft SQL Server
• Derby
• H2

If you choose to install MySQL, you will have to also copy the MySQL JDBC Driver named mysql-connector-
java*.jar in the XWiki's \webapps\xwiki\WEB-INF\lib directory. If don't already have it, you can get it from
here.

Finally, you will have to configure XWiki Enterprise to use the installed database by editing the hibernate.cfg.xml file
located in the \webapps\xwiki\WEB-INF\ folder. In this file, you will need to uncomment the corresponding database
configuration. For instance, if you are using the MySQL database, you will comment the following lines:

<property name="connection.url">jdbc:hsqldb:file:${environment.permanentDirectory}/database/xwiki_db;shutdown=true</
property>
   <property name="connection.username">sa</property>
   <property name="connection.password"></property>
   <property name="connection.driver_class">org.hsqldb.jdbcDriver</property>

http://enterprise.xwiki.org/xwiki/bin/view/Main/Download
http://platform.xwiki.org/xwiki/bin/view/AdminGuide/InstallationTomcat
http://platform.xwiki.org/xwiki/bin/view/AdminGuide/InstallationJetty
http://platform.xwiki.org/xwiki/bin/view/AdminGuide/InstallationGlassFish
http://platform.xwiki.org/xwiki/bin/view/AdminGuide/InstallationWebSphere
http://platform.xwiki.org/xwiki/bin/view/AdminGuide/InstallationJBoss
http://platform.xwiki.org/xwiki/bin/view/AdminGuide/InstallationOC4J
http://platform.xwiki.org/xwiki/bin/view/AdminGuide/InstallationGeronimo
http://platform.xwiki.org/xwiki/bin/view/AdminGuide/InstallationHSQL
http://platform.xwiki.org/xwiki/bin/view/AdminGuide/InstallationPostgreSQL
http://platform.xwiki.org/xwiki/bin/view/AdminGuide/InstallationOracle
http://platform.xwiki.org/xwiki/bin/view/AdminGuide/InstallationDB2
http://platform.xwiki.org/xwiki/bin/view/AdminGuide/InstallationMSSQL
http://platform.xwiki.org/xwiki/bin/view/AdminGuide/InstallationDerby
http://platform.xwiki.org/xwiki/bin/view/AdminGuide/InstallationH2
http://www.mysql.com/products/connector/
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   <property name="dialect">org.hibernate.dialect.HSQLDialect</property>
   <mapping resource="xwiki.hbm.xml"/>
   <mapping resource="feeds.hbm.xml"/>
   <mapping resource="activitystream.hbm.xml"/>
   <mapping resource="instance.hbm.xml"/>

and uncomment the lines below:

<property name="connection.url">jdbc:mysql://localhost/xwiki</property>
   <property name="connection.username">xwiki</property>
   <property name="connection.password">xwiki</property>
   <property name="connection.driver_class">com.mysql.jdbc.Driver</property>
   <property name="dialect">org.hibernate.dialect.MySQL5InnoDBDialect</property>
   <property name="dbcp.ps.maxActive">20</property>
   <mapping resource="xwiki.hbm.xml"/>
   <mapping resource="feeds.hbm.xml"/>
   <mapping resource="activitystream.hbm.xml"/>
   <mapping resource="instance.hbm.xml"/>

In case you have chosen another name for your MySQL database, for instance "projects" make sure you also make the
following changes in the configuration files:

• In the "WEB-INF/hibernate.cfg.xml" file update the line <property name="connection.url">jdbc:mysql://localhost/
xwiki</property> in the MySQL configuration section

• In the "WEB-INF/xwiki.cfg" file uncomment and update the parameter xwiki.db

Manually Import the Default XWiki XAR

The xwiki-enterprise-ui-mainwiki-all-<version>.xar file available here contains a set of default XWiki
pages which you can import in an empty XWiki instance.

The default administrator credentials are Admin/admin. In order to change the username and password (which we strongly
recommend), follow the instructions described in the "Login" and "User Preferences" documentation pages.

Configure the Main Wiki Descriptor

By default a sub-wiki is accessed based on the XWiki Enterprise path. Read about the 'domain name and path based wiki
access' for more details.

There are two ways of accessing the main wiki and of configuring the main wiki descriptor if needed:

• the cleaner way: access the main wiki using the IP (if possible) or a host starting with "www" (like www.xwiki.org) or
with "xwiki" and add the right hosts to the main wiki's descriptor

• the second way: set the xwiki.virtual parameter to false in the xwiki.cfg file; reset it to true once you
have correctly configured the main wiki descriptor

The default first alias in the descriptor is localhost. The first alias is used to generate the external URL, so you should
carefully choose the proper setting. Generally, localhost is not wanted in a production server.

Running Multiple Instances of XWiki in the Same Container
In case you have several instances of XWiki Enterprise in the "webapps" folder of Tomcat (or any other servlet container from
this list), you need to edit the  WEB-INF/cache/infinispan/config.xml file. Next, for each instance of XWiki, you
have to change the jmxDomain value under the globalJmxStatistics tag so that each web application has a unique
name. The default value is org.xwiki.infinispan:

<globalJmxStatistics
      enabled="true"
      jmxDomain="org.xwiki.infinispan"
      cacheManagerName="XWikiCacheManager"/>

Otherwise, you will get the below error message in the console or in the log files:

com.xpn.xwiki.XWikiException: Error number 3 in 0: Could not initialize main XWiki context
Wrapped Exception: Failed to get cache factory component
...
Caused by:
org.infinispan.jmx.JmxDomainConflictException: Domain already registered org.xwiki.infinispan

http://enterprise.xwiki.org/xwiki/bin/view/Main/Download
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Upgrade the Main Wiki

Backup the Existing Data

In order to avoid having post upgrade issues it is essential that you backup your wiki. 

Backup the Database

In case you have installed and configured a relational database it is recommended that you create a copy before upgrading. To
do this execute mysqldump --add-drop-database --databases xwiki > xwiki.sql for MySQL

Backup the Installed Extensions

The extensions installed by the Distribution Wizard or by the Extension Manager are cached in the extensions folder of
the permanent directory set for the servlet container.

Backup the Lucene Index Folder

The default folder that stores the Lucene index is environment.permanentDirectory/lucene. The default value
is defined by the xwiki.plugins.lucene.indexdir property of your WEB-INF/xwiki.cfg file.

Backup the Attachments

If you are storing attachments on the filesystem you will also have to make a copy of the storage folder in the permanent
directory set for the servlet container. The default value is defined by the environment.permanentDirectory
property of your WEB-INF/xwiki.properties configuration file.

Backup the SOLR Index Folder

If you are using SOLR as default search engine you will also have to backup the SOLR index stored in the
environment.permanentDirectory/solr folder.

Since the Solr configuration is stored on the filesystem in the environment.permanentDirectory/solr folder, it
is recommended that you delete the entire folder before the upgrade. The reason for this is the fact that the Solr configuration
might change between releases and by deleting the folder it will be recreated with the new configuration. 

Backup the Configuration Files

In addition to the drivers and plugins you might have installed in your wiki, you also need a backup of several configuration
files:

• the Hibernate configuration file WEB-INF/hibernate.cfg.xml
• the old XWiki Enterprise configuration file WEB-INF/xwiki.cfg
• the new XWiki Enterprise configuration file WEB-INF/xwiki.properties
• the Logging configuration file WEB-INF/classes/logback.xml
• the WEB-INF/cache/infinispan/config.xml file that stores the unique value of jmxDomain; you should

only backup this file when you have multiple XWiki instances in the same servlet container 

These files should be merged with the new versions.

Backup the Skin Folder

If you have a custom skin that is stored on the filesystem, make sure you backup the corresponding folder located in the
webapps/xwiki/skins/ directory. 

Upgrade the Web Application
From a failed migration the database tables DATABASECHANGELOG and DATABASECHANGELOGLOCK may be left
over so please make sure that these tables are dropped before restarting a failed migration.

The recommended strategy is to stop the servlet container, download the xwiki-enterprise-web-<version>.war
file you want to upgrade to then expand it. It is important not to copy the new files on top of the old ones because XWiki
Enterprise would fail due to the old JARs that still remain in the /WEB-INF/lib/ folder.

Next, check that the WEB-INF/xwiki.cfg file is properly configured for a migration as shown below:

#-# Whether migrations are enabled or not. Should be enabled when upgrading, but for a better startup time it is better to
#-# disable them in production.

http://enterprise.xwiki.org/xwiki/bin/view/Main/Download
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xwiki.store.migration=1
#-# Whether to exit after migration. Useful when a server should handle migrations for a large database, without going
#-# live afterwards.
# xwiki.store.migration.exitAfterEnd=0
#-# Indicate the list of databases to migrate.
#-# to upgrade all wikis database set xwiki.store.migration.databases=all
#-# to upgrade just some wikis databases set xwiki.store.migration.databases=xwiki,wiki1,wiki2
#-# Note: the main wiki is always migrated whatever the configuration.
# xwiki.store.migration.databases=

You should also check the Release Notes for all the versions from the version you are upgrading from up to the new version
you are installing in order to find out about the new features or configuration changes.

Restore the Database

The main steps to follow when restoring the MySQL database are:

• Disable the constraints check with mysql -e "SET FOREIGN_KEY_CHECKS=0;"
• Delete the existing xwiki database with mysql -e "DROP DATABASE xwiki;"
• Re-create the xwiki database with mysql -e "CREATE DATABASE IF NOT EXISTS xwiki DEFAULT CHARACTER

SET utf8;"
• Restore the data from the dump file with mysql xwiki --user=root -p < xwiki.sql
• Re-enable the constraints check with mysql -e "SET FOREIGN_KEY_CHECKS=1;"
• Update the password of the "xwiki" user. Note that the user should have all the privileges granted on the database as

explained here. 
• Restart the servlet container

More information regarding the restore process is available on xwiki.org.

Upgrade the XWiki Enterprise XAR

After restarting the servlet container, if you access any wiki page and log in, the Distribution Wizard will be triggered in order
to help you perform the XAR upgrade. The pages that you have already modified will be automatically handled thanks to the
merge conflict resolution feature.

Upgrade the Sub-wikis

Backup the Existing Data

The procedure is similar to the one for the main wiki but this time there are less steps to follow. For each sub-wiki you will ony
have to:

• backup the database
• backup the attachments stored on the file-system in case you have enabled this feature

All the other steps are not necessary since the installed extensions, the Lucene and SOLR indexes, the skin and the
configuration files are shared by the entire farm.

Upgrade the XAR

The easiest way is to let the Distribution Wizard handle the XAR upgrade for sub-wikis and/or workspaces during the second
step of the process. This way, the pages that you have already modified will be automatically handled thanks to the merge
conflict resolution feature. 

Download Older Versions of Our Products
If you are interested in some older versions of the XWiki products you can check this page.
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http://www.xwiki.org/xwiki/bin/view/ReleaseNotes/WebHome
http://platform.xwiki.org/xwiki/bin/view/AdminGuide/Backup#HRestoreyourdata
http://forge.ow2.org/project/showfiles.php?group_id=170
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MySQL Installation and Configuration
• Start the MySQL Server
• Check the MySQL Server
• Create the "xwiki" Database

• Display All Databases
• Give Privileges to the "xwiki" User
• Create a Password For the "root" Admin Account
• Change or Update the "root" Password
• Create the Database Indexes
• Increase the "max_allowed_packet" Value
• See What Values the MySQL Server is Running
• Stop the MySQL Server

MySQL is available at this website. 

Start the MySQL Server
On a Linux machine:

If you are running MySQL as a service:

sudo service mysql start

If you are not running MySQL as a service:

sudo /etc/init.d/mysqld start

On a Windows machine:

If you are running MySQL Server as a service:

>net start mysql

If you are not running MySQL as a service, you should execute the following command to start MySQL as a standalone console
application:

>mysqld --console

Check the MySQL Server
After installing MySQL, you will have to execute the following command in order to check if the MySQL server is properly
started and listening for connections:

For a Linux system:

$ sudo netstat -tap | grep mysql

You should get something similar to:

tcp  0 0 localhost:mysql    *:*   LISTEN      2798/mysqld 

For a Windows system, you have to open the Command prompt as Administrator and run:

>mysqladmin -u root version

You should get something similar to:

Server version   5.5.x
Protocol version 10
Connection       localhost via TCP/IP
TCP port         3306
Uptime           2 hours 30 min

Create the "xwiki" Database
In order to create the "xwiki" database with the UTF-8 binary encoding, you have to run:

>mysql -u root -e "create database xwiki default character set utf8_bin"

http://dev.mysql.com/downloads/
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You can choose another name for your database but you will have to modify the xwiki.db parameter in the xwiki.cfg
file.

Display All Databases

To display all databases, you have to access the MySQL prompt:

On a Linux system:

mysql --user=root mysql
show databases;

On Windows:

>mysql -u root
mysql>show databases;

Give Privileges to the "xwiki" User
To be able to create new wikis, the MySQL user will need to have all the privileges on the database granted. You can use any
username, but make sure you update the connection.username property in the hibernate.cfg.xml file.
In the following example, the username is xwiki. The command  will automatically create the xwiki user in the MySQL
database:

>mysql -u root -e "grant all privileges on *.* to xwiki@localhost identified by 'xwiki'"

Create a Password For the "root" Admin Account
>mysqladmin -u root password //yourpassword//

Change or Update the "root" Password
$ mysqladmin -u root -p'oldpassword' password 'newpassword'

Create the Database Indexes
Since XWiki does not automatically create database indexes, you can use the "Admin Tools" extension available here. 

Increase the "max_allowed_packet" Value
By default, the value of the "max_allowed_packet" parameter is 1M. In order to increase it, you have to start the server with:

On a Linux system:

mysql --max_allowed_packet=32M

On Windows:

>mysqld --max_allowed_packet=32M

The new value can be checked by opening the MySQL prompt and by running:

mysql>show variables like 'max%'; 

You can also set this parameter by editing the my.ini file for Windows, or the /etc/my.cnf file for Linux. If this
parameter is not specified, you can manually add it in the [mysqld] section.

See What Values the MySQL Server is Running
On Linux:

>mysql --user=root mysql
mysql>show variables; 

On Windows:

>mysqladmin -u root variables 

http://extensions.xwiki.org/xwiki/bin/view/Extension/AdminTools
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Stop the MySQL Server
On a Linux machine:

If you are running MySQL as a service:

sudo service mysql stop

If you are not running MySQL as a service:

sudo /etc/init.d/mysqld stop

On a Windows machine:

If you are running MySQL Server as a service:

>net stop mysql

If you are not running MySQL Server as a service:

>mysqladmin -u root -p shutdown
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Wiki Types
There are 3 types of wikis on a XWiki Enterprise farm:

• The wiki administrator: this is the main wiki and it is used to manage the wiki farm
• Wiki templates: the models of wikis used when creating a new wiki instance
• Wiki instances: a wiki created from a wiki template and on which users will work
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• Create a Sub-Wiki
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Create a Sub-Wiki
• The Right to Create Wikis
• Create a Sub-Wiki

• Create a Wiki Template
• Create a Sub-Wiki from a Template

The Right to Create Wikis
Any main wiki user can create wikis, provided he/she has the "createwiki" right which can only be granted via the main wiki,
just like programming rights. To do so, hover the "Home" menu and click on "Administer Wiki".

 

Next, in the preferences page, click on the "Wikis" link from the vertical menu to the left

 

which will bring an overview of the global groups rights.
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Click once on a check-box to allow a right, twice to deny it and three times to clear it. Note that access rights are saved
automatically.

Create a Sub-Wiki
Hover the "Add" menu and click on "Wiki".

You will be redirected to the first step of the new wiki creation wizard allowing you to define:

• the wiki identifier which corresponds to the database name in the database engine; the wiki identifier is also used to
generate the wiki descriptor page which is stored in the main wiki

• the wiki pretty name which represents the display name
• the wiki template to use or whether the wiki is going to be used as template
• a short description of the wiki purpose 

Create a Wiki Template

Supposing you already have the right to create a wiki, the next thing to consider is whether there are wiki templates available.
The list of existing wiki templates (if any) is available in the Wikis section on the main wiki administration page.
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To create a wiki template, it is important that you check the "This wiki will be a template" option during the first step of the
wiki creation wizard.

In case you have enabled the domain name based access, the wizard will display a dedicated field so that you can enter the
new wiki alias.  
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Since this wiki is supposed to be the template, we will choose the default "No template" option from the list.

After filling in the required fields, click on "Go to the Next Step" in which you will get to choose the wiki owner, the scope
and the membership type.
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The default owner is the current global user so, if you wish to delete the entry, hover the user name and click on the red "X"
in the top right corner.

To add the new owner, enter the first characters of the username and the suggest feature will help you by displaying the
occurrences. 

The same principle applies for the sub-wiki "Members". The dedicated input has improved allowing you to add multiple users
at once. 
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To remove a member, hover the corresponding user name and click on the red "X" in the top right corner. In case you want to
remove all the members at once, click on "Clear selection".

The owner is automatically added as initial member of the sub-wiki so you won't need to add it again in this section.

Each type of membership defines a different kind of sub-wiki:

• any user can join the wiki (an open wiki)
• any global user can make a join request, but an administrator has to accept it (a join-by-request wiki)
• only the administrator can make invitations (an invitation-only wiki)

Also, there are 3 possible user scopes which will tell you the type of users that will have access to the sub-wiki:

• only global users (main wiki users)
• only local users (users that will be created locally on the sub-wiki)
• both local and global users

After filling in the required fields, click on "Create" and the Distribution Wizard will be triggered and will start to initialize
the wiki.
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Click on "Continue" to get to the first step of the wizard. If you click on "Never" or "Later", the sub-wiki will still be created
along with the corresponding database, but it will be empty. Next, click on "No, this is a new install". 

You will then see the recommended set of pages that will be installed on the new sub-wiki:

• XWiki Enterprise - UI - Common
• Wiki Application for subwikis
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Click on "Install" and you will be prompted about the new extensions.

Click on "Continue" to confirm and the Distribution Wizard will start computing the install plan and downloading
extensions. 
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Once the install process starts, there might be some merge conflicts reported, even when the database is empty. To learn more
about how to handle them, follow this link.
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When the progress bar has reached 100%, go to the "Dependencies" tab to see the list of installed extensions which are
marked by a green status bar and click on "Continue". 
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Since this is a new install, there aren't any existing extensions to be upgraded, so the wizard will skip the second step, i.e.
"Extensions". You will be then redirected to the third step of the wizard, "Report", which displays all the changes made to the
wiki so that you can perform rollbacks, as explained in the Distribution Wizard documentation page. 

Click on "Continue" to access the new sub-wiki home page. In the "Wiki Information" section you will see a welcome
message with the name and description of the wiki and also with information about the owner.
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The same information along with the list of members is available in the "Wiki Information" panel. The panel is not displayed
by default, you can use the Panel Wizard for this purpose.

Create a Sub-Wiki from a Template

After creating a default wiki template, it is time to create a sub-wiki that will use it. Unlike the above section, we will choose the
"Template Wiki" as template. After clicking on "Go to the Next Step", the system will start provisioning the wiki, which means
allocating memory and creating the database.



XWiki Enterprise 5.4.4 Admin Guide

Page 271

In case the process fails, there will be an explanatory error message displayed and a button for cleaning and deleting the wiki.

Otherwise, the Distribution Manager will be triggered just like in the above section.
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Wiki Directory
To access the wiki list, hover the "Home" menu to the top of the page and click on "Wiki Index".

If you are an administrator or the wiki owner, you will see a "Delete" link in the "Actions" column. If you are a member with
no privileges, you will only see the "Leave", "Join" or "Request Join" actions, depending on your current membership.
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• Manage the Sub-Wiki Users
• Edit the Sub-Wiki Settings
• Delete a Sub-Wiki
• Create a Sub-Wiki



XWiki Enterprise 5.4.4 Admin Guide

Page 274

Edit the Sub-Wiki Settings
• Edit the Wiki Descriptor

• Edit the Wiki Owner
• Wiki Aliases

• The Sub-Wiki Administration Page

In order to have the necessary privileges to administer a sub-wiki, you need to either be its owner or an administrator.

Edit the Wiki Descriptor
You can customize most of a sub-wiki properties from its descriptor page:

• pretty name
• owner
• home page
• whether the wiki is used as template for other wikis
• whether the generated external URLs are using the HTTPS protocol

Moreover, the descriptor page can be used to create, edit and remove sub-wiki aliases.

All sub-wiki descriptors are stored in the main wiki and can be accessed from the Wiki Directory by clicking the
corresponding "edit" link in the "Actions" column.

Next, edit the page in "Inline" mode and start making changes.
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Edit the Wiki Owner

The owner is a global user that he has all the privileges granted on the sub-wiki.
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To delete the entry, edit the descriptor page in "Inline" mode, hover the user name and click on the red "X" in the top right
corner.

 

To add the new owner, enter the first characters of the username and the suggest feature will help you by displaying the
occurrences.

 

A sub-wiki cannot have multiple owners but it does support multiple administrators. Both the owner and the administrators can
edit or delete the sub-wiki or manage its members.

Wiki Aliases

A wiki can have several aliases apart from the primary one which can only be edited, but never deleted because it holds the
descriptor.

To add an alias, go to the descriptor page, locate the "Create a New Alias" section, enter the name of the new alias and click
on "Create". 

 

The new alias will be displayed in the "View Aliases" section. 
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To add a description or to change the home page, just edit the descriptor in "Inline" mode.

To remove the alias, click the "Delete" button.

The Sub-Wiki Administration Page
Additional configurations related to membership type, user scope and members can be done from the sub-wiki administration
page. To do so, hover the "Wiki" menu and click on "Administer Wiki"
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then click on "Users" in the vertical menu to the left. After modifying the membership type or the user scope, don't forget to
click on "Save".

Depending on this configuration you can add, invite or accept join requests from global users as described in the dedicated
documentation page.
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Delete a Sub-Wiki
You can delete a wiki only if you are the owner or an administrator. The first way is via the Wiki Directory, by clicking on
"Delete" in the "Actions" column.

Next, in the "Delete wiki" page, click on "Yes" to confirm.

Another way is to go to the wiki home page, hover the "Wiki" menu, then click on "Delete".

In the "Delete wiki" page, click on "Yes" and if successful you will get a confirmation message.
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Other XWiki Applications
The XWiki Extensions repository provides a list of applications that are not bundled with XWiki Enterprise but that you could
find very useful:

• Wiki Manager Application - allows you to easily create, modify and delete wikis in virtual mode. 
• Menu Application - helps you create navigation menus that will be displayed either horizontally as a top bar after the page

header or vertically in a side panel. 

 

Related Pages

• Programming Guide
• XWiki Platform Plugins

http://extensions.xwiki.org/xwiki/bin/view/Main/WebHome
http://extensions.xwiki.org/xwiki/bin/view/Extension/Menu+Application
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The Wiki Manager Application
• Create a Wiki
• Set or Unset a Wiki Template
• Edit the Wiki Descriptor

• Change the Wiki Pretty Name
• Edit the Wiki Owner
• Set the Wiki as Template
• Set the Wiki Alias

• Create a Wiki Alias
• Remove a Wiki Alias
• Edit a Wiki Alias

• Edit the Wiki Description
• Change the Wiki Home Page
• Secure the Wiki

• Access the Wiki
• The Domain Name Based Access
• The URL Path Based Access

• Delete a Sub-Wiki

Starting with the 5.2 version, the support for XWiki Enterprise Manager has been stopped and the Wiki Manager Application is
no longer provided by the default distribution. In case you still want to use it, you can install it with Extension Manager.

The "Wiki Manager" application allows you to easily create, modify and delete wikis in virtual mode. 

To access the Wiki Manager home page, after you have installed the Wiki Manager Application, click on the "Wiki Manager"
link from the "Applications" panel.
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The Wiki Manager allows you to:

• Browse the wiki directory
• Create a wiki
• Set a wiki as template
• Edit the wiki descriptor
• Delete a Sub-Wiki
• Filter the wikis based on their names, domain name, administrator, creation date and templates.

Create a Wiki
In order to create a wiki, go to the Wiki Manager home page click on the "Create new wiki" link. The "Wizard view mode" will
be displayed by default to create the wiki descriptor document in the main wiki and its associated database or schema.

To display the entire form on the same page, click on "Switch to normal view mode".

The wiki identifier can be applied:

• as database name in the database engine used as the XWiki back-end.
• to target the wiki pages from another wiki with the syntax: wikiidentifier:Space.Name.
• to generate the wiki descriptor page name in the main wiki XWiki.XWikiServerWikiindentifier.

Click on "Next" and you should see the image below:

Fill in the wiki identifier and click on "Next".

Note that the name of the wiki identifier must contain only lowercase alphanumeric characters.

Fill in the "Pretty name" of the wiki (which is the display name) and the "Description",

the "Alias" and the wiki "Owner", then click on "Next". To learn more about wiki aliases, go the below section.
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By default, the wiki alias ends with "localdomain.com" which is used in a domain-based access. More details about the ways
of accessing a wiki (domain-based or path-based) are available in the documentation page about how to below section.

Note that the wiki creation form now uses the new User Picker which displays the user avatar. The default owner is the global
farm administrator. To delete the entry, hover the user name and click on the red "X" in the top right corner. 

You may choose to create the wiki:

• from a wiki template 
• from an attached file

In our case, we will choose the "Main wiki" template:

Before the actual wiki creation, you can set the rights for:

• Readers
• Writers
• Administrators
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Click on "Next" and you should see the "Summary" page. At this point, you can modify any information about your wiki, by
clicking on "Previous":

Click on "Create" to confirm which will lead you to the wiki creation page containing an additional information message
announcing you that your wiki has been successfully created and that it is available at the address ServerName/xwiki/bin/view/
Main/:

You should then see your wiki displayed in the Wiki Manager home page:
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Set or Unset a Wiki Template
To set a wiki as template, go to the Wiki Manager home page and click on "Set" in the corresponding "Wiki template" column.

An information message will appear right above the livetable announcing you that the visibility of your wiki has been set to
"true".

You can do the same thing by clicking on "Settings" in the "More settings" column.

Next, edit the wiki descriptor page in "Inline" mode and check the "Wiki Template" check-box.
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To reverse the process, click on "Unset" in the corresponding "Wiki template" column.

Once again, an information message will appear announcing you that your wiki visibility has been set back to "false".

You can do the same thing by clicking on "Settings" in the "More settings" column. Next, edit the page in "Inline" mode and
uncheck the "Wiki Template" check-box.

Edit the Wiki Descriptor

Change the Wiki Pretty Name

In order to edit the wiki pretty name, go to the "Wiki Manager" home page. Next, click on "Settings" in the corresponding
"More actions" which will load the wiki descriptor.
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Edit the descriptor page in "Inline" mode and fill in the new pretty name.

Edit the Wiki Owner

The owner is considered as a "super administrator" of the wiki, meaning that he has all the privileges granted and that he cannot
lose them. To change the owner of the wiki, go to the "Wiki Manager" home page and click on "Settings" in the corresponding
"More actions" column. Next, edit the wiki descriptor page in "Inline" mode and locate the new User Picker which displays the
user avatar.

To delete the entry, hover the user name and click on the red "X" in the top right corner.

 

To add the new owner, enter the first characters of the username and the suggest feature will help you by displaying the
occurrences.
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Set the Wiki as Template

This property indicates if the wiki can be used as a template when creating a new wiki. In order to learn how to enable/disable
this property, go to the dedicated section.

Set the Wiki Alias

To create, remove or modify the alias of the wiki, go to the "Wiki Manager" home page and click on "Settings" in the
corresponding "More actions" column.

Create a Wiki Alias

Go to the "Create new alias" section from the wiki descriptor, fill in the new alias and click on "Create".

A "View aliases" section will then appear, containing a "Description" and a "Home page" subsection for each new alias.
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Remove a Wiki Alias

It is not possible to delete the first alias because it represents the wiki descriptor. To delete any other alias, click on the "Delete"
button located in the "View aliases" section from the wiki descriptor.

Edit a Wiki Alias

To modify an alias, edit the wiki descriptor page in "Inline" mode. At this point you can either change the first alias 

or the newly created one.

Each wiki alias is in fact an "XWiki.XWikiServerClass" object. The first object represents the general wiki descriptor and all
its content is used to describe the wiki itself. The other object(s) is(are) just used for the alias data like the name, description
and home page.

Edit the Wiki Description

If you want to change the description of the wiki, go to the "Wiki Manager" home page and click on "Settings" in the
corresponding "More Actions" column. Next, edit the wiki descriptor page in "Inline" mode and enter a description in the
editing area. Note that you can modify the description for every wiki alias.
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Change the Wiki Home Page

The home page is used to generate the URL associated with the alias. You can retrieve it using the getWikiUrl() method as
shown below:

$xwiki.wikimanager.getWikiDocument("manager").getWikiUrl()

In order to change the home page, go to the "Wiki Manager" home page and click on "Settings" in the "More Actions"
columns. You can perform this for every wiki alias by editing the wiki descriptor page in "Inline" mode and by filling in the
"Homepage" field.

Secure the Wiki

By enabling the "Secure" option, all the generated external URLs of the wiki will start with https. To do so, edit the wiki
descriptor page in "Inline" mode and check the "Secure" check-box.

Access the Wiki

The Domain Name Based Access

In virtual mode, you can access any wiki using the domain name or the alias registered in its descriptor with the field server
("Alias" in the UI). For example, if the URL is WikiName/xwiki/bin/view/Space/Page, the value of the server field will be
"wikiname.xwiki.org". XWiki will search this value in the "XWiki.XWikiServerClass" objects, then it will extract the last part
of the page name in order to get the wiki identifier. In this case, the page name will be "XWiki.XWikiServerWikiname" and
"Wikiname" will be extracted as the wiki identifier.

When no descriptor is found:

• if the host is an IP address (127.0.0.1, 85.65.12.36, etc.), XWiki selects the main wiki
• else, if the first part of the host name is "www", XWiki selects the main wiki
• else, if the first part of the host name matches a wiki identifier, XWiki selects this wiki

If no wiki is found, XWiki redirects to the URL configured in the xwiki.virtual.redirect parameter of the
xwiki.cfg file.

So, to be able to access your wiki you need :

• to configure your DNS OR
• to modify the hosts file in your operating system.

Note that this mode is disabled by default. To enable it, set the xwiki.virtual.usepath parameter to 0 in the
"xwiki.cfg" file. 

http://platform.xwiki.org/xwiki/bin/view/AdminGuide/Virtualization
http://en.wikipedia.org/wiki/Domain_Name_System
http://en.wikipedia.org/wiki/Hosts_file


XWiki Enterprise 5.4.4 Admin Guide

Page 292

The URL Path Based Access

This mode is enabled by default so you can access a wiki using an URL like WikiName/xwiki/wiki/WikiAlias/view/Space/Page.

The wiki part is used by XWiki to identify the URL as an URL path based multi-wiki access. This is configurable through
the property xwiki.virtual.usepath.servletpath from the xwiki.cfg file.

Note that you have to set the xwiki.authentication.logoutpage property accordingly. Modify the "wiki" part
inside the value of the property for the right alias.

The wikialias part is used by XWiki to find the wiki descriptor. It first tries to match wikialias with the descriptors.
If it cannot find the descriptor, it will try to match the wiki descriptor using wikialias as the wiki identifier. This means
looking whether the "XWiki.XWikiServerWikialias" document exists and if it contains an "XWiki.XWikiServerClass" object.

Delete a Sub-Wiki
It is not possible to delete the main wiki.

In order to delete a sub-wiki, go to the "Wiki Manager" home page, click on "Delete" in the corresponding "More settings"
column and confirm.
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